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ЛАБОРАТОРНАЯ РАБОТА №1 
ГРАФИЧЕСКИЙ РЕДАКТОР P-CAD Schematic 

 
Целью лабораторной работы является  изучение  основных  команд и режимов работы 

графического редактора P-CAD Schematic. 
 
1  Назначение графического редактора P-CAD Schematic 
 
Графический редактор P-CAD Schematic предназначен для  графического ввода и 

редактирования схем  и выполняет следующие основные функции: 
•  размещение и редактирование, изменение размеров объекта, многострочное 

развертывание,  drag and drop перемещение, и выравнивание; 
•  определение пользователем свойства схем, элементов, связей;  
•  проводники и шины, которые несут информацию и свойства; 
•  обширная проверка правил проектирования с отображением ошибок и отклонений 

на экране; 
•  перекрестное проектирование с P-CAD PCB; 
•  улучшенные двунаправленные ECO возможности; 
•  автоматическое соединение проводников и размещение соединений с шиной; 
•  редактирование и выбор опций с помощью одного нажатия мыши; 
•  поддержка иерархического проектирования схем; 
•  библиотека компонентов единая для использования в P-CAD Schematic и P-CAD 

PCB; 
•  доступны стандартные размеры схем. 
 
2 Пользовательский интерфейс PCAD Schematic 
 
После входа в систему экран имеет  вид,  представленный  на рис. 1.1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  Рисунок 1.1 - Структура экрана редактора PCAD Schematic 



На рис. 1.1 показаны следующие области: 
 
1. Menu Bar. Меню позволять выполнять Schematic команды и функции. 

 
2. Command Toolbar. Тулбар команд предоставляет быстрый доступ к командам меню и других 

системных функций.  

 

 
 выбор режима редактирования   вставить из буфера   
 
  создать новый файл                отмена выполненных действий 
  
  открыть файл      ручное проведение проводников  
  
 сохранить файл     переименование проводника 
 
 печать файла      измерение расстояния 
 
 поместить в буфер и удалить   увеличить масштаб 
 
 поместить в буфер     записать ECO 
 
 

3. Placement Toolbar. Тулбар размещения предоставляет быстрый 
доступ к командам  размещения  

 

 
 поместить элемент    поместить многоугольник 
 
 поместить проводник   поместить точку 
 
 поместить шину    поместить текст 
 
 поместить порт    поместить атрибут 
 
  поместить вывод    поместить поле 
 
 поместить линию    поместить IEEE символ 
 
 поместить дугу 
 
 

4. Prompt Line. Строка подсказки находится рабочей областью и является верхней 
полосой в области подсказки/статуса.  

 

 
 



5.  Status Line. Строка статуса – это область внизу экрана и ее можно убирать или 
показать, используя View Status Line команду.  

Строка статуса отображает следующие свойства (слева направо). 
А)  Координаты X и Y. 
Эти два значения показывают позицию курсора при движении его внутри рабочей 

области. Можно ввести точные значения координат X and Y 
точки на экране. 
Б)  Кнопки переключения сетки. 

Кнопка переключения сетки и комбо-бокс сетки расположены рядом и позволяют  
легко переключаться между настройками сетки и добавлять новые настройки сетки. Кнопка 
переключает между абсолютной (absolute grid - Abs) и относительной  (relative grid - Rel) 
сетками. Значения абсолютной  и относительной  сеток  могут быть изменены с помощью 
комбо-бокс. Клавиша A переключает тип сетки. 

Для переключения настройки сетки можно использовать выпадающий список комбо-
бокса или с помощью клавиш G или Shift-G. 

В)  Кнопка записи макроса.     
Кнопка записи макроса позволяет создавать временный макрос. Этот временный 

макрос называется  DEFAULT в программе. Обычно, можно использовать этот макрос для 
уменьшения времени создания проекта (например, относительное размещение линий). 
Клавиша M аналогична кнопке M . Для исполнения записанного макроса используется 
клавиша Е. 

Г)  Лист-бокс выбора схемы. 

Лист-бокс выбора схемы и скролбар позволяют быстро изменять текущую схему. 
Также можно использовать клавиши L или Shift-L. 

Д)  Комбо-бокс ширины линии. 

С помощью этого комбо-бокса можно выбирать ширину линии или добавлять новую 
ширину линии в список. Для переключения настройки сетки можно использовать 
выпадающий список комбо-бокса или с помощью клавиш W или Shift-W 

Е)  Область информации о статусе 

 
В этом поле отображается следующая информация: 

• описание выбранного объекта либо специфическое (тип 
или обозначение) или общее (число выбранных 
элементов); 

• имя выбранного проводника; 
• результаты команды Edit Measure. 

 
6. Workspace. Рабочая область (the workspace) место для создания схемы. 

Настройка рабочей области производится с помощью команды Options Configure. С 
помощью этой команды можно настраивать следующие параметры рабочей области: 

• размер рабочей области (workspace size); 
• рамку схемы (title sheet); 
• режим рисования линий (orthogonal modes); 
• авто сохранение (AutoSave); 
• единицы измерения (units) и д.р. 



 
 
3 Команды PCAD Schematic 
 
В данном разделе кратко описываются только те команды  графического редактора 

PCAD Schematic, которые могут быть использованы при выполнении данной лабораторной  
работы  -  команды  подключения библиотек и размещения элементов.  

 
Команды ввода/вывода 
File/New  - создание нового файла; 
File/Load  -  загрузка файла в память редактора; 
File/Save  - запись файла на магнитный носитель; 
File/SaveAs  - запись файла на магнитный носитель с новым именем; 
File/Close  - закрыть файл. 
 
Команды размещения элементов 
Place/Part  - поместить элемент; 
Place/Wir  - поместить проводник; 
Place/Bus  - поместить шину; 
Place/Por  - поместить порт; 
Place/Pin  - поместить вывод; 
Place/Lin  - поместить линию; 
Place/Arc  -  поместить дугу; 
Place/Polygon  - поместить многоугольник; 
Place/Ref Point  - поместить точку; 
Place/Text  - поместить текст; 
Place/Attribute  - поместить атрибут; 
Place/Field  -  поместить поле; 
Place/IEEE Symbol - поместить IEEE символ. 
 
Команды настройки библиотек 
Library/New  - создать новую библиотеку; 
Library/Alias  - присвоение компоненту псевдонимов; 
Library/Copy  - скопировать компонент из одной библиотеку в другую; 
Library/Delete  - удалить компонент из библиотеки; 
Library/Rename  - переименовать компонент в библиотеке; 
Library/Setup  - настроить список библиотек; 
Library/Symbol Save As- сохранить часть схемы как символ; 
Library/Archive Library- перенос из открытых библиотек в отдельную библиотеку 

всех компонентов, находящихся в текущем проекте. 
 Перед размещением  элементов на схеме необходимо настроить список библиотек. 

Для этого необходимо с помощью команды Library->Setup вызвать диалог Library Setup . 
С помощью кнопки Del удалить все библиотеки из списка, а затем добавить библиотеку 
Ti_7400.lib после нажатия кнопки Add из каталога PCAD2000\Lib. Для размещения 
элемента используется команда Place->Part и в диалоге можно выбрать текущую 
библиотеку (Library ),  обозначение элемента на схеме (Ref Des), значение для резисторов, 
конденсаторов и т.д. (Value), номер секции в многосекционных элементах (Part Num), тип 
символа связанного с элементом (Alternate), а также тип компонента (Component Name). 

 
4 Назначение клавиш 
 
Назначение клавиш отображено в таблице 1.1  
 



 
Таблица 1.1 - Назначение клавиш 
Наименование Назначение 

A Переключение шага сетки 
C Центрирование изображения курсора относительно точки 

расположения курсора 
D, Shift-D Увеличение (уменьшение) позиционного обозначения 

компонента (при выполнении команды Place>Part) 
E Выполнение временного файла макрокомад (_DEFAULT). 
F Зеркальное отображение графических объектов относительно 

оси Y 
G,Shif+G Изменение шага сетки. 
J Ввод координат X,Y в строке статуса. 
L, Shift-L Изменение текущего листа схемы 
M Запуск/остановка записи временного файла макрокомад 
O, Shift-O Изменение параметров проведения проводника 

(Ortho=90,45,Any). 
P, Shift-P Увеличение (уменьшение) позиционного обозначения 

компонента (при выполнении команды Place>Part) 
Q Изображение контуров линий и полигонов (не заливая их 

краской) 
R Поворот объекта на 90 градусов 
S Включение режима выбора объекта. 
U Отмена последней команды 
W, Shift- W Переключение ширины линии 
X Переключение вида курсора 
Y Вызов меню Options Layers 
Z Вывод на экран окаймленной части изображения 

Backspace Стирание последнего сегмента линии 
Esc Завершение ввода объектов щелчками мыши 
Серый ‘+’ Увеличение масштаба изображения 
Серый ‘-‘ Уменьшение масштаба изображения 
Del Удаление выбранных объектов 

 
ЗАДАНИЕ ПО ЛАБОРАТОРНОЙ РАБОТЕ 
 
Разработать библиотечные элементы согласно варианта, приведенного в таблице 1.2. 

Таблица 1.2 - Варианты заданий 
№  варианта Элемент Аналог № Варианта Элемент Аналог 

1 155ЛА1 7420 12 155ЛИ1 7408 
2 155ЛА2 7430 13 155ЛП5 7486 
3 155ЛА3 7400 14 155ЛА10 7412 
4 155ЛН1 7404 15 155ЛА11 7426 
5 166ЛА6 7440 16 155ЛА13 7438 
6 155ЛА7 7422 17 155ЛЛ1 7432 
7 155ЛА8 7401 18 155ЛЕ2 7423 
8 155ЛР1 7450 19 155ЛЕ3 7425 
9 155ЛР3 7453 20 155ЛЕ5 7428 
10 155ЛР4 7454 21 155ЛП10 74365 
11 155ЛЕ1 7402 22 155ЛП11 74367 



ЛАБОРАТОРНАЯ   РАБОТА  №2. 
СОЗДАНИЕ БИБЛИОТЕК ЛОГИЧЕСКИХ ЭЛЕМЕНТОВ  

В САПР PCAD- 2000/2001 
 

Целью лабораторной работы является изучение основ построения  описания  
логических  элементов  в графических  редакторах PCAD Schematic и PCAD PCB. В 
результате выполнения лабораторной  работы студент должен овладеть навыками 
формирования описания  логического элемента в среде  системы проектирования  PCAD.  
Структура формируемого описания должна соответствовать стандартной  структуре 
описания логического элемента, принятого в системе проектирования PCAD. 
 

ОБЩИЕ ПОЛОЖЕНИЯ 
 

Библиотека логических (символьных) элементов  системы  PCAD состоит из 
совокупности символьных  элементов  различных  серий, которые формируются 
пользователем  по  определенной  схеме.  Для создания нового  символьного  элемента  
необходимо  сформировать соответствующие слои этого элемента, которые образуют базу  
данных этого элемента, и записать эту базу на магнитный носитель. В последствии 
созданное  описание  используется  при  формировании принципиальных схем, размещении 
и трассировки печатных плат, при моделировании и т.д. Описание  символьного  элемента  
содержит  всю  информацию, необходимую для работы с этим элементом. Эта  информация  
включает условное графическое изображение элемента  (УГО),  описание всех его 
входов/выходов, упаковочную информацию (количество элементов в одном корпусе, 
нумерацию контактов в корпусе и т.д.). Графический редактор PCAD Schematic 
предназначен для  графического ввода/редактирования схем, библиотечных элементов 
выполняет следующие основные функции: 

-  построение библиотечных элементов; 
-  построение принципиальных схем. 

Графический редактор PCAD PCB предназначен для графического 
ввода/редактирования  конструктивов  библиотечных  элементов,  символьное 
представление которых задано в редакторе PCAD Schematic и работы с печатными платами. 
Он выполняет следующие основные функции:  

- построение конструктивов библиотечных элементов; 
- работа с печатными платами. 

 
ПОРЯДОК СОЗДАНИЯ СИМВОЛЬНОГО ЭЛЕМЕНТА 
 
Опишем последовательность создания компонентов на примере интегральной схемы 

однородной структуры со штыревыми выводами 155ЛА3 -  четырех логических элементов 
2И-НЕ (компоненты с планарными выводами создаются также). 

 
1 Создание символа компонента в PCAD Schematic  
 
Сначала по команде Options-> Configure выбирают  систему единиц и по команде 

Options->Grid  устанавливают необходимый шаг сетки, в данном примере метрическая 
система, шаг сетки 5 мм. 

Затем по команде Place->Line и Place->Arc рисуется контур символа линиями 
шириной 0,25 мм.  

Текстовые надписи наносят по команде Place->Text, выводы – по команде Place->Pin. 
В меню этой команды (рис. 2.1) в графе Display нужно включить опции Pin Name и Pin Des 
(видимость на схеме  имен и номеров выводов), в графе Length указать длину выводов 
(Short -2,5 мм, Normal - 7,6 мм, Long - 12,7 мм, User - назначается пользователем). Графику 



выводов выбирают в графе Display Characteristic. В таб. приведен перечень выводов 
символов компонентов и их графика (одновременно можно выбрать только один тип 
вывода). После этого щелчками мыши размещаются выводы символа. Вращение выводов 
на 90 выполняется нажатием клавиши R, не отпуская кнопки мыши (при этом изменяет 
ориентацию и позиционное обозначение вывода, которое при необходимости в дальнейшем   
перемещают вручную). 

 
Рисунок 2.1- Меню команды простановки выводов 

 
В результате рисуется заготовка символа ИС К155ЛАЗ (рис. 2.2, a). Далее по команде  

Place->Attributes размещают атрибуты RefDes и Type. Все выводы символа получают 
одинаковое позиционное обозначение по умолчанию (на рис. 2.2 b задан номер 0). Выводы 
нумеруют по команде Utils->Renumber, меню которой приведено на рис. 2.3. В графе Туре 
выбирают режим  нумерации  выводов Default Pin Des и на строках Starting Number и 
Increment Value задаются начальное значение и приращение позиционных обозначений 
выводов. Для нумерации выводов их по очереди  выбирают курсором, начиная с первого. В 
качестве  точки  привязки по команде Place->Point обычно отмечают верхний  левый  
вывод символа  (рис. 2.2, b). 

 
Рисунок 2.2- Символ компонента с проставленными выводами 

 
Замечание. При создании символа многосекционного компонента, таким образом, 

нумеруются  только выводы первой секции, а выводы остальных секций нумеруются позже 
в таблице выводов Pins View. 

В заключение все объекты, относящиеся к символу компонента,  выбираются в окне,  
и выполняется команда его занесения в библиотеку Library->Symbol Save As, при этом 
элемент должен быть выделен весь. В меню этой команды (рис. 2.4) выбирают  имя  одной 
из открытых библиотек,  куда нужно занести созданный символ, и вводят  его имя, 



например LА3. При этом нельзя включать параметр Create Component, если компонент 
будет создан позже с помощью Library Manager. 

 
Рисунок 2.3- Нумерация выводов символов 

 
Немного проще символ создается в PCAD Symbol Editor. Во-первых, команда Place-

>Pin имеет более наглядное меню, и по окончании обычно не требуется перенумеровывать 
выводы. Во-вторых, имеется мастер создания символов          Symbol->Symbol Wizard. И, 
в-третьих, созданный символ заносится в библиотеку непосредственно по команде File-
>Save.  

  
Рисунок 2.4-Занесение символа компонента в библиотеку 

 
 
2 Создание корпуса компонентов в PCAD PCB 
 
 Сначала по команде Options-> Configure выбирают систему единиц  и по команде  

Options->Grid  устанавливают необходимый шаг сетки, равный расстоянию между 
выводами, в данном примере выбрана метрическая система с шагом сетки       2,5 мм. 

Затем в два ряда размещаются 14 выводов с шагом 2,5 мм между выводами и 
расстоянием между рядами 7,5 мм. В качестве стиля стека контактных площадок с 
помощью команды Options->Pad Style выбирают стиль по умолчанию DEFAULT или 
любой другой. Сначала по команде Place->Pad размещают первый вывод компонента. 
Остальные выводы можно разместить двумя способами. Во-первых, все их можно 
разместить вручную, продолжая выполнение команды Place->Pad. Однако удобнее 
скорректировать первый вывод, выбрав его, выполнив команду Edit->Copy Matrix : в окне,  
показанном на рисунке 2.5. Устанавливают число рядов Number of Columns - 2, расстояние 
между рядами Column Spacing - 7,5 мм, число строк Number of Rows - 7, и расстояние 
между выводами Row Spacing - 2,5 мм. Затем шаг сетки уменьшают до 0,5 мм, и на слое Top 



Silk рисуется контур компонента   с помощью команд Place->Line и Place->Arc линиями 
шириной 0,2 мм; результат показа на рис. 2.6. 

 

 
Рисунок 2.5- Простановка выводов в два ряда 

 
Далее на слой Top Silk по команде Place->Attributes/Components размещают 

атрибуты RefDes и Type (последний повернут на 90 градусов). 
При размещении выводов все они по умолчанию получили порядковый номер 0. 

Автоматическая нумерация выводов выполняется по команде Utils->Renumber, 
предварительно включив режим выбора. 

В диалоговом меню команды указывают тип нумерации Pad Num,  начальный номер 1 
(Starting Number). Для присвоения номеров выводы по очереди помечают курсором 
согласно цоколевке корпуса в порядке, указанном на рис. 2.6.  В качестве точки привязки 
по команде Place->Point/RefPoint отмечают верхний левый (или нижний левый) вывод 
компонента (при необходимости также отмечают Glue Dot, Pick and Place и Test Point). 

Рисунок 2.6- Создание контура компонента 

 
В заключение все объекты, относящиеся к корпусу компонента, выбирают в окне и 

выполняют команду занесения его в библиотеку Library->Patern Save As. В меню  этой 
команды указывают имя одной из  открытых библиотек, куда  нужно  занести корпус, и 
вводят имя корпуса, например DIP14. 

Замечание. При выполнении команды Library->Patern Save As нельзя выбирать 
опцию Create Component, если компонент будет создан позже с помощью Library 
Executive. Опцию Match Default Pin Des to Pad Numbers, наоборот, нужно включить, 
чтобы позиционные обозначения выводов по умолчанию совпали с введенными ранее 
номерами выводов компонента Pad Numbers. 

Намного проще корпус создается в PCAD Pattern Editor. Во-первых, после 
расстановки выводов по команде Place->Pad обычно не требуется их перенумеровывать. 
Во-вторых, имеется мастер  создания корпусов Pattern->Pattern Wizard. И, в третьих, 
созданный корпус заносится  в библиотеку  непосредственно по команде File->Save. 

 



3 Создание компонента с помощью Library Executive 
 
После загрузки Library Executive или Library Manager выполняется команда создание 

нового компонента Component->New, и в ее диалоговом окне указывают файл библиотеки, 
в который ранее занесены корпус и символ компонента. Затем на экран выводится окно 
Component Information. В нем сначала нажимают кнопку Select Pattern для подключения 
графики корпуса компонента. В открывшемся окне Library Browse из списка корпусов 
помещенных в открытую библиотеку выбирают нужный корпус – в рассматриваемом 
примере DIP14. Затем вводят следующую информацию.  
1) В строке Number of Gates  указывают число секций, в данном примере – 4. Число  

выводов компонента проставляется на строке Number of Pads автоматически. В строке 
RefDes Prefix указывают префикс позиционного обозначения компонента, в данном 
примере DD. После этого становится доступной панель Select Symbol, после нажатия, 
на которую выбирают имя основного изображения символа компонента, в данном 
примере LA3. 

2) В графе Component Type выбирают тип компонента Normal. 
3) В графе Component Style для однородного компонента выбирают строку  Homogeneous. 
4) В графе Gate Numbering выбирают буквенный способ именования секций компонента 

Alphabetic (первая секция в графе Gate # в таблице на рис. 2.7 получит номер A, вторая 
– B и т.п.). Все секции однородных компонентов по умолчанию получают одинаковый 
код логической эквивалентности Gate Eq, что позволит их автоматически переставлять 
в процессе размещения компонентов на печатной плате. 

5) В графе Alternate View можно включать альтернативные варианты изображения 
символа компонента. Если сделать это, то в таблице на рисунке 2.7 помимо графы 
Normal появятся дополнительные графы IEEE и DeMorgan. В данном примере этого 
делать не будем. 

 
4 Редактирование таблицы выводов компонента  
 
Создание компонента завершается заполнение таблицы выводов, которая выводится 

на экран нажатием кнопки Pins View. Это самая трудоемкая часть работы по созданию 
компонента. 

Во-первых, нужно установить соответствие между номерами выводов всех секций 
Sym Pin # и позиционными обозначениями выводов корпуса Pin Des, (порядковые номера 
выводов Pad Numbers обычно полагают равными Pin Des). Заметим, что в таблице Pins 
View строки выводов 13 и 14 пустые, потому что 4 секции 2И-НЕ имеют только 12 
выводов, а 2 оставшихся предназначены для цепей питания. В ИС серии К155 вывод 7 
соединяется с “землей”, а вывод 14 с источником питания.  

Сначала скопируем содержание столбца Pad # в столбец Pin Des. Затем выделим 
курсором всю строку 13, кроме ячейки Pin Des, и нажатием на пиктограмму 
 или на клавиши Ctrl + ^ переместим ее на строку 7. Далее заметим, что информация 
о номерах выводов секций 3 и 4 не соответствует ИС серии К155, и исправим ее, перемещая 
соответствующие строки. 

Затем в колонке Pin Name введем имена выводов первой секции. Для этого курсором 
выделим соответствующую ячейку и введем необходимую информацию, которая появится 
на строке над таблицей. Нажатием кнопки Enter введенные данные переносятся в 
выделенную ячейку. Нажатие Esc отменяет ввод. Копирование данных выделенной ячейки 
производят нажатием клавиши Ctrl + C , затем выделяют ячейку, куда нужно эти данные 
скопировать, и нажимают комбинацию клавиш Crtl + V.   

В графах Gate Eq и Pin Eq эквивалентным секциям и входным выводам каждой 
секции присваивается одинаковый код эквивалентности, в данном примере равный 1 (что 
разрешит менять их местами в процессе автотрассировки). 



 

 
Рисунок 2.7- Меню Component Information 

 
В графе Elec. Type указывают тип вывода, используемый при поиске ошибок в 

принципиальных электрических схемах. Нажатие на правую кнопку мыши открывает 
список типов выводов (Electrical Type), приведенный в таблице 2.1. Для быстрого выбора 
типа вывода достаточно напечатать первый символ его имени. Например, ввод символа I 
присваивает тип Input . Если имеется несколько типов выводов, начинающихся на один и 
тот же символ, этот символ вводят второй раз, затем третий и т.д., циклически перебирая 
все варианты. 

Замечание. Для простановки символа логической инверсии в имени вывода 
используется знак “~”. 
Таблице 2.1- Выводы символов компонентов 
 
Тип вывода Назначение 
Unknown Выводы, не имеющие определенного типа. Назначаются по 

умолчанию (эквивалентно пустой ячейке). 
Passive Вывод пассивного компонента (не имеющего источников энергии) 
Input Входные выводы 
Output Выходные выводы 
Bi-directional Двунаправленные выводы 
Open-H Открытый эмиттер ИС типа ЭСЛ (к нему должен быть подключен 

нагрузочный резистор) 
Open-L Открытый коллектор ИС типа ТТЛ (к нему должен быть подключен 

нагрузочный резистор) 
Passive-H Пассивный компонент (обычно резистор), подключаемый к источнику 

питания (соответствует высокому логическому уровню) 
Passive-L Пассивный компонент (обычно резистор), подключаемый к “земле” 

(соответствует низкому логическому уровню) 
3-state Тристабильный вывод (имеет высокий и низкий логический уровень и 

уровень высокого импеданса) 
Power Подключение вывода питания или “земле”. Назначение типа Power 

автоматически проставляет номер секции PWR в столбце Gate # 
таблицы выводов (вместо PWR оставить пустую ячейку или ввести 0) 

 
 
 



 

 
 

Рисунок 2.8-Таблица выводов компонента до и после редактирования 
 
 
5 Сохранение компонентов библиотеки   
 
Перед сохранением в библиотеке компонента необходимо выполнить команду 

проверки Component->Validate. При обнаружении ошибок выводятся информационные 
сообщения, например: 

Missing Pin Des in Row 1. Only ‘unused’ pads are allowed to have a blank Pin Des. 
(пропущен номер вывода в строке 1; только неиспользованные выводы могут не иметь 

информации, а графе Pin Des) 
или 
The gate  equivalence specified in Component Information for gate 4 does not match the 

pin’s gate  equivalence specified in row 14. 
(Код логической эквивалентности, введенный в окне Component Information для 

секции 4, не соответствует коду логической эквивалентности, указанному в строке 14). 
-Если же ошибок не обнаружено, программа сообщает: 
No errors found! 
 

 
Рисунок 2.9 - Сохранение компонента в текущей библиотеке 

 
После исправления всех ошибок выполняется команда сохранения компонента в 

текущей библиотеке Component->Save или Component->Save As. Однако перед 
выполнением этих команд все равно проверяется наличие ошибок, и пока ошибки не 



исправленных, компонент сохранить нельзя. Имя нового компонента указывают по 
дополнительному запросу (рис. 2.9).  

Замечание. Символы компонентов заносятся в библиотечные файлы *.LIB по команде 
Library->Symbol Save (As) графических редакторов. В диалоговом окне этой команды 
имеется опция Create Component. Если ее отметить то созданный символ (или корпус) 
будет занесен в библиотеку как неполноценный компонент, не имеющий корпуса (символа) 
и текстовой информации; по умолчанию он не зависимо от типа компонента получит 
префикс позиционного обозначения U; однако, его можно немедленно наносить на схему 
(печатную плату) по команде Place->Part(Place->Component). Если же опцию Create 
Component не отмечать, то он будет доступен для размещения только после создания 
полноценного компонента с помощью Library Manager (или Library Executive), при этом, 
однако имеется возможность задать правильный префикс позиционного обозначения. 
 
ЗАДАНИЕ ПО ЛАБОРАТОРНОЙ РАБОТЕ 

 
1. Изучить назначение и состав САПР PCAD. 
2. Освоить порядок работы с графическим редактором PCAD Schematic. 
3. Подготовить в редакторе PCAD Schematic библиотеку  условных графических 

обозначений (УГО)  логических  элементов заданной принципиальной схемы. 
4. Освоить порядок работы с графическим редактором PCAD PCB. 
5. Подготовить в редакторе PCAD PCB библиотеку конструктивов логических элементов 

заданной принципиальной схемы. 
6. Создать в Library Manager библиотеку компонентов на основе библиотеки  условных 

графических обозначений и библиотеки конструктивов заданной принципиальной 
схемы. 

 
Замечание. При создании компонентов конденсаторов и разъема примеры компонентов 
находится в папке PCAD2000/Lib в библиотеках Discrete.lib и Connect.lib. 
 
СОДЕРЖАНИЕ ОТЧЕТА 

 
1. Схема электрическая принципиальная  заданного  устройства (А4) (на миллиметровке). 
2. УГО элементов с указанием их параметров (на  миллиметровке). 
3. Двоичный файл библиотеки компонентов  (A01.lib, где A - группа А, 01 - номер 

варианта по журналу) 
4. Файлы УГО и конструктивов элементов (*.sym и *.prt). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



ЛАБОРАТОРНАЯ РАБОТА №3. 
ПРОЕКТИРОВАНИЕ  СХЕМ ЭЛЕКТРИЧЕСКИХ 

ПРИНЦИПИАЛЬНЫХ В ГРАФИЧЕСКОМ 
РЕДАКТОРЕ P-CAD Schematic 

 

Целью лабораторной работы является изучение принципов и овладение навыками 
проектирования  принципиальных электрических схем в редакторе PCAD Schematic. В  
этом редакторе осуществляется размещение  условного  графического  обозначения  (УГО) 
элементов на рабочем поле  редактора,  проведение  электрических цепей между 
элементами, присваивание элементам позиционных обозначений, формирование шин и т.д. 

 
ПОРЯДОК СОЗДАНИЯ ПРИНЦИПИАЛЬНОЙ СХЕМЫ 

 
1 Загрузка библиотек  
 
Перед нанесением на схему символов компонентов по команде L обеспечивается 

доступ к необходимым библиотекам (рис 3.1.). Нажав клавишу. А, добавляют имена 
библиотек в список открытых библиотек (Open Libraries). С помощью клавиши Delete 
удаляют библиотеки из этого списка, чтобы освободить место для других. С помощью  
клавиш Move Up , Move Down изменяют порядок их расположения в списке (нужно 
учитывать, что при поиске компонентов библиотеки просматриваются в списке в 
направлении сверху - вниз). 

 
 

Рисунок 3.1- Список открытых библиотек 
 

2 Размещение компонентов на схеме 
 

В режим размещения символов компонентов на схеме переходят по команде    Place-
>Part,. После этого щелчок курсором в любой точке схемы открывает меню выбора 
компонента (рис. 3.2.). 

В графе Num Parts указывается общее число секций компонента (изменять их  на 
этом этапе нельзя). Например, ИС564ЛА7 имеет четыре логических элемента (секции) 2И-
НЕ. В окне Part Num по умолчанию  указывается номер секции 1, но при необходимости 
его можно изменить перед размещением символа компонента на схеме.  

Нажатие клавиши Q активизирует средства поиска компонента в открытых 
библиотеках. Сначала в диалоговом окне Query в столбцах Criteria задают критерии поиска 
и в столбце Show отмечают, какие характеристики найденных компонентов нужно 
отображать в таблицах результатов поиска. 

 



 
 
 

 
Рисунок 3.2- Выбор символа компонента 

 
  При задании критериев поиска  используются следующие операторы: 

= в точности равно, если используются символы обобщения * или ?, то 
проверяется равенство текстовых переменных; 

<  меньше, чем;  
>  больше, чем; 
<=  меньше, чем или равно; 
>=  больше, чем или равно; 
<>  не равно; 

 IsLike  при использовании символов обобщения IsLike означает 
«подобно». Например, IsLike  5* может быть равно 50, 510, 5 и т.п.; 

IsNotLike при использовании символов обобщения I эквивалентно «не равно». 
Например, I 5* может быть 14, 20, или 422, но не 50, 510 или 5; 

Exist атрибут существует; 
Not Exit атрибут не существует; 
Any Value атрибут существует и имеет некоторое значение; 
No Value атрибут существует, но значение ему не присвоено. 
 
Позиционные обозначения компонентов на схеме проставляются автоматически. 

Например, если из импортной библиотеки интегральных микросхем ТТЛ серии 7400 
последовательно размещать на схеме 4-секционную ИС 7408, то первый элемент 
приобретет позиционное обозначение U1:А. Префикс позиционного обозначения U  
назначен при создании  компонента (при необходимости его можно заменить, например на 
DD), номер первого компонента 1 и имя первой секции А проставляются автоматически, 
т.е. первый элемент получит позиционное обозначение U1:А. Второй элемент получит  
позиционное обозначение U1:В, третий -  U1:С, четвертый- U1:D, пятый  - U2:А и т. д. Для 
изменения назначенного в библиотеке префикса позиционного обозначения его надо 
указывать в поле RefDes в явном виде. Для компонентов, состоящих из одной секции, имя 
секции не проставляется. 

На рисунке 3.3  приведены результаты простановки позиционных  обозначений для 
4-секционной ИС 7408 с использованием буквенных обозначений секций (А, В, и т.д.). По 
ЕСКД секции нумеруются цифрами (1,2 …). Для этого в программе PCAD Library Manager 



необходимо в меню Component Information выбрать способ числовой нумерации секций 
Gate Numbering: Numeric. 

 

Рисунок 3.3 -Автоматическая простановка позиционных обозначений компонентов 
 
Секции компонентов получат обозначения DD1:1, DD2:2 и т.д., как этого требует 

ЕСКД (по ЕСКД требуется  отделять номер секции не двоеточием, а точкой: DD1.1, DD1.2 
и т.д.). При изображении многосекционных компонентов совмещенным  способом 
(изображения смежных  секций примыкают друг к другу) позиционные  обозначения 
отдельных секций обычно не указываются, для этого необходимо параметры RefDes всех 
секций, кроме первой, сделать невидимыми (выключать кнопку Visibility), тогда будет  
видно позиционное   обозначение только первой секции, например DD9:1.  

На строке Value проставляют номинал компонента, например сопротивление 
резистора. 

После выбора в меню Place->Part нужного компонента и введения необходимых 
параметров нажимают Ok – курсор примет форму перекрестия с разрывом в центре для 
точного позиционирования в узлах сетки. Непосредственное размещение символа 
компонента на схеме выполняется после щелчка курсором в любой точке окна. До тех пор, 
пока не отпущена левая кнопка мыши, символ перемещается по экрану. Он поворачивается 
на 90 градусов в направлении против часовой стрелки и зеркально отображается нажатием 
клавиш R и F соответственно. Повторный щелчок курсором размещает на схеме очередную 
копию символа выбранного компонента, присваивая ему следующие позиционные 
обозначения, которые одновременно выводятся в строке информации. Для увеличения на 1 
номера секции компонента перед размещением символ нажимают клавишу P, а для 
увеличения - клавишу D. Уменьшить эти значения можно одновременным нажатием 
клавиш Shift-P или Shift-D. Нажатие правой кнопки мыши или Esc прекращает ввод 
символа. 

 

3 Размещение электрических цепей 
 
После выбор команды Place->Wire курсор принимает форму перекрестья. Щелчком 

мыши отмечается начальная точка цепи. Каждое нажатие левой кнопки мыши фиксирует 
точку излома. Нажатие клавиши 0 до опускания левой кнопки мыши изменяет угол ввода 
линии из числа размещенных вариантов, нажатие клавиши F изменяет ее ориентацию. В 
связи с тем, что на схеме обычно преобладают горизонтальные или вертикальные цепи, в 
меню Options->Configure достаточно включить только режим ввода ортогональных цепей 
90/90 Line-Line. Завершается ввод цепи нажатием правой кнопки мыши или Esc. 

Ширина прокладываемой цепи устанавливается по команде Options->Current Wire : 
Thick – широкая (шириной 0.381 мм  = 15 мил), Thin – узкая (шириной 0.254 мм  = 10 мил) 
и User – задаваемая пользователем (в пределах от 0.1 до 100 мил). 

Присвоить цепи другое имя можно 2 способами. 



Во-первых, индивидуально выбрать каждую цепь и щелчком правой кнопки мыши 
открыть меню редактирования пункт Properties. На экране появится информация о 
выбранной цепи (рис. 3.4.). На закладке Net можно изменить имя цепи, заменив на строке 
Net Name назначенное системой имя другим. Это имя будет видимым, если включить на 
закладке Wire переключатель Display. Тип и размер шрифта имени указывают после 
нажатия на клавишу Text Styles. На закладке Net можно также задать значения различным 
атрибутам цепи, нажав на клавишу Net Attrs. 

 
Рисунок 3.4-Меню редактирования имен и атрибутов цепей 

 
Во-вторых, можно упростить ввод имен групп цепи имеющих однородные имена 

типа D1, D2, и т.д., и их переименование. Для этого нужно выбрать команду Utils>Rename 
Nets, щелкнуть курсором в любой точке схемы и в открывающемся меню на строке Net 
Name ввести префикс имени, например IN, и выбрать параметр Increment Name (режим 
приращения имени). После закрытия этого меню щелчком курсора по первой цепи ей 
присваивается имя IN0, по второй IN1 и т.д. Что бы начать нумерацию цепей не с 0, нужно 
начальное имя ввести в явном виде, например DATA5. Тогда первая цепь получит имя 
DATA5, вторая DATA6 и т.д. 

 

4 Размещение шин 
 
Выбор команды Place->Bus активизирует режим ввода шин. Щелчком курсора 

отмечают начало шины и точки ее излома. Построение шины завершается нажатием правой 
кнопки мыши или Esc.  

После этого по команде Place->Wire размещают цепи. При рисовании цепи, 
входящей в состав шины, ее начало или конец должны располагаться в любой точке шины. 
При этом при подключении к шине автоматически изображается излом цепи по углом 45 
градусов (стиль этого изображения устанавливают в меню командой Options->Display). 

Имена цепей, образующих шину задаются подключением к цепям по команде Place-
>Port специальных портов (командами Edit->Nets и Util->Rename Nets в этих целях 
пользоваться не рекомендуется). После выбора команды Place->Port щелчком мыши на 
любой точке схемы открывается изображенное на рисунке 3.5 меню выбора порта. На 
расположенной вверху строке Net Name указывают имя первой цепи, например D1. Если 
включить переключатель Increment Port Name, то при размещении портов они 
автоматически получат имена D1, D2, и т.д. 

 



 
Рисунок 3.5 -Диалоговое окно команды Place->Port 

 

5 Создание и заполнение угловых штампов  
 
Файлы угловых штампов (основных надписей) создаются как файлы схем, но им 

присваивают расширения имени *.TTL (папка PCAD2000\Titles). Эти файлы размещаются 
на чертеже двояко. Во-первых, их можно загрузить по команде File->Open и затем 
приступить к созданию схемы. Во-вторых, имена этих файлов можно указать в диалоговом 
окне команды Options->Configure после нажатия на панель Edit Title Sheets. 
Непосредственный выбор имени файла производится после нажатия на панель Select, 
изображение рамки наносится на чертеж после выбора опции Display Border. Введенные 
изменения настроек сохраняются после нажатия на панель Modfy . Надписи и линии 
углового штампа после подключения его к схеме по второму способу становится 
недоступными для редактирования. Пользователь может только заполнить строки данных, 
заключенные в фигурные скобки. Строки данных наносят по команде Place->Field, в меню 
которой вводятся данные двух типов. 

1. Информация о текущих данных, которые автоматически обновляются: 
Current Date – текущая дата; 
Current Time – текущее время; 
FileName – имя файла; 
Number of Sheets – число листов; 
Sheet Number – номер текущего листа. 

2. Данные, заполняемые при редактировании схемы: 
{Author} – фамилия автора; 
{Date} – дата создания; 
{Revision} – дата изменения; 
{Time} – время создания; 
{Title} – название проекта. 

Для заполнения данных второго типа открывают закладку Fields диалогового окна 
команды File->Design Info. 

 

6 Изменение позиционных обозначений 
 
Перед завершением создания схемы целесообразно переименовать позиционные 

обозначения компонентов по команде Utils->Renumber. В меню этой команды (рис 3.5) 
выбирают объект перенумерации RefDes и порядок простановки позиционных обозначений 
Top to Bottom (сверху вниз) или Left to Right (слева направо), что не совпадает с 
требованиями ЕСКД. После нажатия на клавишу Ok позиционные обозначения 
перенумеровываются в заданном порядке. Перенумерация согласно ЕСКД производится 
вручную или с помощью специальной утилиты DBX. 



 
 
 
 
 
 
 

Рисунок 3.5- Меню команды перенумерации позиционных обозначений и выводов 
компонентов 

7 Сохранение проекта 
 
По команде File->Save отредактированный проект сохраняется в исходном файле, по 

команде File->Save As проект сохраняется в другом файле, причем предварительно можно 
выбрать его формат: 

Binary files – бинарный формат; ASCII files – текстовый формат. 

8 Верификация схемы  
 
После создания принципиальной электрической схемы целесообразно выявить 

синтаксические ошибки, исправить их и только после этого перейти к разработке печатной 
платы. Проверку схемы выполняют по команде Utils->ERC (Electrical Rules Check). В 
основном меню этой команды (рис 3.6) задается перечень проверок, результаты которых 
приводятся в текстовом отчете: 

Single Node Nets – цепи, имеющие единственный узел; 
No Node Nets – цепи, не имеющие узлов; 
Electrical Rules – электрические ошибки, когда соединяются выводы несовместимых 

типов; 
Unconnected Pins – неподключенные выводы компонентов; 
Unconnected Wires – неподключенные (плавающие) цепи;  
Bus/Net Errors – входящие в состав шины цепи, встречающиеся только один раз; 
Component Rules – компоненты расположенные поверх других компонентов; 
Net Connectivity Rules –неправильное подключение цепей “земли” и питания;  
Hierarchy Rules – ошибки иерархической структуры. 
Степень серьезности отдельных ошибок (Error, Warning или Ignored) назначается в 

диалоговом окне (рис 3.6), открываемом после нажатия на панель Severity Level. Кроме 
того, в меню, показном на рис 3.6, необходимо включить опции View Report (просмотр 
отчетов) и Annotate Errors (индификация ошибок на схеме). 

Поиск ошибок в соответствии с заданной конфигурацией начинается после нажатия 
панели Ok. Информация об ошибках помечается на схеме индикаторами и выводится в 
текстовый отчет. 

 
 
 
 
 
 
 
 
 
 

Рисунок 3.6 -Настройка конфигурации ERC: выбор перечня и назначение типа ошибок 



9 Создание списка соединений 
 

Список соединений включает в себя список компонентов и цепей с указанием 
номеров выводов компонентов, к которым они подключены. Он используется для так 
называемой процедуры “упаковки схемы на печатную плату”  - размещение на поле 
печатной платы корпусов компонентов с указанием их электрических связей согласно 
принципиальной схеме. По команде Utils->Generate Netlist открывают меню настройки 
параметров (рис 3.7). В пункте меню Netlist Format выбирается формат списка соединений: 
PCAD ASCII, Tango, FutureNet Netlist, FutureNet Pinlist, Master Designer, EDIF 2.0.0, PSpice, 
Xspice. Для разработки печатной платы с помощью графического редактора PCAD PCB 
рекомендуется выбирать формат PCAD ASCII, который передает атрибуты схемы на 
печатную плату. 

 
 
 
 
 
 
 
 

Рисунок 3.7- Составление списка соединений 

10 Составление отчетов 
 
По команде File->Reports создают текстовые отчеты о схеме. Заданные в 

диалоговом окне этой команды установки сохраняются файлы конфигурации SCH.INI. В 
разделе Report to Generate выбирают следующие виды отчетов: 

Attributes – список атрибутов компонентов и цепей (*.ATR); 
Bill of Materials – список компонентов (*.BOM); 
Clobal Nets – список глобальных цепей с указанием номера листа схемы (*.GNR) 
Last Used Refdes – список последних значений позиционных обозначений 

компонентов всех типов  (*.LUD); 
Library Contents – список компонентов содержащихся во всех открытих библиотеках 

(*.LCT); 
Parts Locations – список позиционных обозначений компонентов схемы и координат 

их расположения с указанием номера листа (*.PLC); 
Parts Usage – список неиспользованных секций в много секционных компонентов 

(*.PTU). 
 

ЗАДАНИЕ ПО ЛАБОРАТОРНОЙ РАБОТЕ 
1.   Выполнить загрузку библиотек.  
2.   Разместить компоненты, электрические цепи и шины на схеме. 
3.   Создать и заполнить угловые штампы на схеме  
4.   Задать позиционные обозначения компонентов схемы. 
5.   Выполнить верификацию схемы. 
6.   Создать список соединений и отчеты. 
 
СОДЕРЖАНИЕ ОТЧЕТА 

1. Файл схемы электрической принципиальной (A01.SCH); 
2. Файл  описания связей (A01.NET); 
3. Файл сообщений об ошибках  (A01.ERC); 
4. Файлы отчетов (A01.ATR – A01.PTU). 



ЛАБОРАТОРНАЯ  РАБОТА   № 4. 
РАЗМЕЩЕНИЕ ЭЛЕМЕНТОВ НА ПЛАТЕ 

 
Целью  лабораторной работы является освоение подготовительных этапов, 

предшествующих трассировке, и размещение элементов на печатной плате. 
 

Перед размещением компонентов на плату определяется шаг сетки рабочего поля. 
Например, для компонентов с планарными выводами этот шаг устанавливается равным 
1,25 мм, а для компонентов со штыревыми выводами - 2,5 мм.  

Затем необходимо в слое Board нарисовать на рабочем поле монитора замкнутый контур 
печатной платы. Прорисовка производится с помощью команд Place/Line и Place/Arc.  

Если отсутствует принципиальная схема, выполненная в P-CAD Schematic, то 
компоненты на плату устанавливают по команде Place/ Component. Связи между 
компонентами проводят по команде Place/ Connection.  

Если же принципиальная схема имеется, то производится так называемая упаковка 
схемы на печатную плату (должна быть открыта нужная библиотека).  

1 Упаковка схемы на печатную плату  
 

Вначале необходимо по команде Utils/Load Netlist (рис. 4.1) загрузить файл списка 
соединений (расширение *.net) печатной.  

 

Рисунок 4.1- Меню команды загрузки файла соединений  

 

 



В диалоговом окне используются следующие опции:  

• Netlist Filename - выбор имени файла списка соединений на жестком диске. В 
списке Netlist Format перечислены имена форматов списка цепей: Tango, Master 
Designer ALT (стандартный текстовый файл предыдущих версий P-CAD для DOS, 
включающий в себя и список соединений) и текстовый файл P-CAD ASCII.  

Если выбран последний формат, то становится доступной область Attribute Handling, в 
которой задается режим обработки атрибутов:  

• Merge Attributes (Favor Netlist) - объединение атрибутов списка цепей с текущими 
атрибутами цепей проекта; приоритет за атрибутами списка цепей;  

• Merge Attributes (Favor Design) - объединение атрибутов списка цепей с текущими 
атрибутами цепей проекта; приоритет за атрибутами цепей проекта;  

• Replace Existing Attributes — замена текущих атрибутов проекта на атрибуты 
списка цепей;  

• Ignore Netlist Attributes - игнорирование атрибутов списка цепей;  

• Флажок Optimize Nets — включает режим оптимизации длин соединений путем 
«перестановки» логически эквивалентных вентилей и контактов. Если этот режим 
выключен, то связи проводятся в том порядке, в котором они записаны в списке 
соединений. Флажок рекомендуется включить после упорядочивания размещения 
компонентов вручную или по команде Utils/Optimize Nets;  

• Флажок Reconnect Cooper — разрешает подключать к цепям схемы имеющиеся на 
плате участки металлизации. Если этот режим выключен, то имеющиеся на плате 
экраны рассматриваются как свободные области;  

• Флажок Check for Cooper Sharing - включает режим проверки наличия ошибок на 
плате с предварительно размещенными компонентами и частью предварительно 
проведенных соединений. В результате часть электрических соединений считается 
уже оттрассированной или подлежит дотрассировке.  

• Флажок Create Pseudo Pattern - допускает загрузку списка соединений, 
содержащего ссылки на компоненты, не имеющие подсоединенных корпусов (см. 
главу 2 «Создание компонентов и менеджер библиотек проекта»).  

Если списки цепей выполнены в формате P-CAD ASCII, то возможны два варианта 
настройки атрибутов цепей. Настройка классов цепей производится в области Net Class 
and Rules Handling:  

• Replace Existing Net Classes — замена существующих классов цепей проекта 
классами цепей из списка цепей;  

• Ignore Netlist Net Classes - игнорировать существующие классы цепей.  

 

Если выбран формат Master Designer ALT, то становится доступным флажок 
Xreference File, активизирующий кнопку Xref Filename для определения 
многолистового ALT-файла.  

Как правило, схема упаковывается на печатную плату, на которой предварительно 
размещены разъемы и другие фиксированные компоненты (после выделения 



соответствующих компонентов в диалоговом окне Properties устанавливается флажок 
Fixed) и проложены некоторые цепи.  

После загрузки команды Utils/Load Netlist выводится сообщение (рис. 4.2) о 
необходимости соблюдать следующие ограничения:  

• компоненты с совпадающими на плате и схеме позиционными обозначениями 
(RefDes) должны иметь одинаковый тип корпуса (Туре). В противном случае 
упаковка схемы не производится;  

• все компоненты, установленные на плату перед упаковкой, но не входящие в список 
соединений, будут сохранены;  

• на печатную плату переносятся все компоненты из списка соединений, которые 
предварительно не были установлены на плату;  

• предварительно проложенные электрические связи, но отсутствующие в списке 
соединений, будут удалены (обновляется вся информация об электрических цепях). 
Однако все предварительно проложенные проводники, присутствующие в списке 
соединений, будут сохранены;  

• после выполнения команды нельзя восстановить первоначальный вид печатной 
платы с предварительно размещенными компонентами, поэтому ее рекомендуется 
сохранить в отдельном файле.  

 
Рисунок 4.2- Сообщения о загрузке списка соединений на плату, имеющую 

предварительно установленные компоненты и проведенные связи 

 

После нажатия на кнопку Yes загружаемые компоненты проекта размещаются над 
верхней границей печатной платы (если уже размещена заготовка печатной платы). Если 
же нет заготовки печатной платы, то все компоненты размещаются в левом нижнем углу 
рабочего пространства проекта. При этом на экране отображаются прямые линии еще не 
проведенных электрических связей.  

При установке курсора (не нажимая левую кнопку мыши) на объект размещения 
появляется информация о позиционном обозначении компонента, его типе и значении 
атрибута компонента, а для электрической цепи — ее номер (имя) и имена компонентов 
и их контактов, которые цепь соединяет.  

По команде Library/Setup  можно просмотреть перечень открытых библиотек.  

Теперь можно размещать компоненты схемы в контуре печатной платы.  

 

2 Размещение компонентов на плате  
После упаковки схемы на печатную плату можно приступать к размещению 

компонентов на плоскости платы. Попытки разработки алгоритмов для автоматического 
размещения компонентов на плату, увы, не привели к сколько-нибудь приемлемым 



результатам, удовлетворяющих разработчика. Слишком много условий, которые не 
поддаются формализации, возникает при разработке каждого проекта. Поэтому 
утвердилась практика размещать компоненты на плату вручную.  

«Паутина» линий связей, появляющаяся между компонентами, позволяет 
разработчику ориентироваться при размещении компонентов. При перемещении 
компонентов указанная «паутина» перемещается вместе с компонентом. Компоненты 
при установке можно разворачивать (клавиша R) или переносить на противоположную 
сторону платы (клавиша F).  

При размещении компонентов можно скрыть или сделать видимыми электрические 
связи для одной или нескольких цепей, можно переименовать одну цепь или группу 
цепей, можно отредактировать значения атрибутов. Для этих и других целей служит 
диалоговое окно команды Edit/Nets (рис. 4.3).  

В окне Nets отображены имена всех цепей проекта, а в окне Nodes указаны имена 
компонентов и номера их контактов, связанные с выделенной цепью. Можно выделить 
все цепи списка (кнопка Set All Nets). Или после нажатия на кнопку Set Nets By 
Attribute выделить все цепи, имеющие одинаковое значение атрибута (например, 
одинаковую ширину проводника Width). Выделение цепей по атрибуту производится в 
появившемся диалоговом окне. Снятие выделения всех цепей производится кнопкой 
Clear All Nets.  

 

Рисунок 4.3- Диалоговое окно команды Edit/Nets 

 

Нужную цепь можно выделить по ее имени.  

Кнопка Set Nets By Node Count позволяет выбрать цепи с минимальным и 
максимальным числом контактов, значения которых устанавливаются в окнах Min  и 
Мах.  

Кнопка Edit Attributes разрешает перейти к редактированию или установке 
атрибутов выделенной цепи. Кнопка View Attributes открывает редактор Notepad для 
просмотра установленных атрибутов цепи.  

 



 

Нажатие кнопки Info отражает всю информацию о выделенной цепи.  

Кнопка Show Conns подсвечивает на экране все фрагменты, соответствующие 
выбранной цепи, а кнопка Show Conns Only on Drag включает видимость всех связей 
только при перемещении компонента.  

Кнопка Hide Conns скрывает отображение выделенной цепи и ее связей.  

Кнопки Highlight и Unhighlight высвечивают или убирают подсветку выделенной 
цепи или цепей. Если выделена цепь и ее узел в окне Nodes, то нажатие кнопки Jump to 
Node позволяет перейти к указанному узлу. Кнопка Select позволяет перейти к 
редактированию выбранной цепи.  

Кнопка Pad Properties позволяет изменить стиль контактной площадки.  

 

3 Автоматическое выравнивание компонентов на печатной плате  
 

Для автоматического выравнивания компонентов после размещения на печатной 
плате вначале их надо выделить (при выборе второго и последующего компонентов 
удерживать клавишу Ctrl ). Затем нажать правую кнопку мыши, выбрать точку привязки 
Selection Point и установить ее в точку печатной платы, относительно которой будет 
производиться выравнивание. Вновь нажать правую кнопку мыши и выбрать строчку Align . 
В области Alignment диалогового окна (рис. 4.4) выбрать одно из трех возможных 
направлений выравнивадия:  

 

 

Рисунок 4.4- Окно команды выравнивания компонентов на плате 

• Horizontal Aboute Selection Point - выравнивание по горизонтали относительно указанной на плате 
точки привязки;  

• Vertical Aboute Selection Point - выравнивание по вертикали относительно точки привязки;  

• Onto Grid — выравнивание в узловые точки сетки.  

В области Component Spasing, если установлен флажок Space Egually, то в окне 
Spacing можно точно установить расстояние между выравниваемыми компонентами в 
выбранной системе единиц.  



Заметим, что указанные команды выравнивания не действуют на зафиксированные 
компоненты. 

 

4 Оптимизация электрических связей  
 

Данная операция проводится перед началом трассировки соединений на печатной 
плате с целью минимизации общей длины физических связей между компонентами и 
оптимизации гистограммы плотности соединений. Для этой цели применяется команда 
Utils/Optimize Nets, окно которой представлено на рис. 4.5.  

В области Method можно выбрать режим оптимизации:  

• Auto — автоматическая оптимизация;  

• Manuel Gate Swap — ручная парная перестановка эквивалентных вентилей;  

• Manuel Pin Swap - ручная парная перестановка эквивалентных выводов.  

 

Рисунок 4.5- Окно команды Utils/ Optimize Nets 

При выборе автоматического метода размещения в области Auto Options доступны 
следующие опции:  

• Gate Swap - перестановка эквивалентных вентилей;  

• Pin Swap — перестановка эквивалентных выводов;  

• Entire Design — оптимизация связей в пределах всего проекта (после выделения всех компонентов).  

Опция Selected Objects оптимизирует связи между предварительно выбранными 
объектами.  

При перестановке выводов должны соблюдаться определенные условия:  

• величина логической эквивалентности вывода Pin Eg не должна быть равно нулю. И 
это значение должно быть одинаковым для двух переставляемых выводов. 
Перестановка неэквивалентных выводов производится только вручную;  

• при подсоединенной к выводу цепи или области металлизации перестановка 
выводов не производится;  

• если цепь, присоединенная к выводу, имеет атрибут Optimize="No" (цепь не 
оптимизируется), то перестановка выводов не производится;  

• если компонент имеет атрибут Noswap="Yes" (запрещение перестановки 
компонента), то перестановка выводов не производится.  



 

При перестановке вентилей должны соблюдаться определенные условия:  

• вентили должны быть логически эквивалентными и принадлежать к компонентам одного и того же 
типа (Туре) и номинала (Value). Это условие позволяет переставлять дискретные компоненты — 
резисторы, конденсаторы и т. п.;  

• если цепь, присоединенная к выводу, имеет атрибут Optimize="No", то перестановка вентилей не 
производится;  

• если компонент имеет атрибут Noswap="Yes", то перестановка вентилей не производится;  

• при подсоединенном к выводу вентиля проводнике или области металлизации перестановка вентилей 
не производится.  

После нажатия кнопки ОК происходит оптимизация электрических соединений и 
появляется сообщение, вид которого представлен на рис. 4.6.  

 

 

Рисунок 4.6- Сообщение о результате автоматической перестановке вентилей и выводов 
компонентов 

В сообщении указываются параметры оптимизации цепей (Setting), текущее состояние 
процесса оптимизации (Current Status) и отчет о результатах оптимизации (Cumulative 
Status):  

• Numbers of gates Swapped - число переставленных вентилей;  

• Numbers of pins Swapped — число переставленных выводов;  

• All net total length before - общая длина цепей до оптимизации;  



• All net total length after - общая длина цепей после оптимизации;  

• All net total length changed — относительное изменение общей длины цепей после оптимизации;  

• Selected net total length before — длина выбранных цепей до оптимизации;  

• Selected net total length after — длина выбранных цепей после оптимизации;  

• Selected net total length changed - относительное изменение выбранных цепей после оптимизации.  

Для ручной перестановки вентилей в окне Utils/Optimize Nets (рис. 4.7) включают 
флажок Manual Gate Swap и нажимают кнопку ОК. Курсор принимает форму 
диагонального перекрестья. Отменяется режим перестановки нажатием правой кнопки 
мыши или клавиши Esc. Затем щелкают по контактной площадке первого переставляемого 
вентиля. В результате все цепи, подсоединенные к выбранному вентилю, окрашиваются в 
голубой цвет. А все цепи и выводы, принадлежащие эквивалентным вентилям, 
окрашиваются в фиолетовый цвет. Далее щелкают по выводу вентиля, который надо 
переставить с первым выбранным вентилем. Появляется диалоговое окно (рис. 4.7), в 
котором, отображается текущая длина цепей (столбец Manhattan Length) и возможное 
изменение их относительной (столбец Percent change) длины при перестановке вентилей.  

 

Рисунок 4.7- Диалоговое окно команды Utils/Optimize Nets/ Manuel Gate Swap 



 

Нажмите кнопку Swap для выполнения перестановки.  

В случае попытки перестановки неэквивалентных вентилей раздается предупреждающий 
звуковой сигнал.  

Все перестановки необходимо зафиксировать в файле изменений (ЕСО-файл) после 
выполнения команды Utils/Record ECOs. Этот файл используется для последующей 
коррекции схемы.  

ЗАДАНИЕ ПО ЛАБОРАТОРНОЙ РАБОТЕ 
 

1. Произвести упаковку схемы на печатную плату.  
2. Разместить компоненты на плате.  
3. Произвести автоматическое выравнивание компоненты на печатной плате.  
4. Произвести оптимизацию электрических связей.  
 
СОДЕРЖАНИЕ ОТЧЕТА 
 
Выходной файл – файл прешествующий трассировке с расширением *.PCB 

 



ЛАБОРАТОРНАЯ  РАБОТА   №5. 
ТРАССИРОВКА ЭЛЕКТРИЧЕСКИХ СОЕДИНЕНИЙ 

 
Целью лабораторной работы является овладение навыками использования 

различных методов трассировки печатных соединений. 

Перед началом трассировки формулируется ряд правил и ограничений, которые 
должны выполняться при ручной и автоматической трассировке, а также при 
формировании областей металлизации.  

1 Установка шага сетки  
В некоторых случаях, кроме регулярной сетки, для трассировки можно использовать 

и нерегулярную сетку с целью 100-процентной прокладки всех соединений схемы. 
Например, если шаг между выводами компонента задан величиной 2,5мм и диаметр 
контактной площадки-равен 1,5 мм, то для прокладки двух проводников толщиной 0,2 мм 
между соседними выводами при допустимой величине зазора 0,2 мм необходимо задать 
сетку 1,05 мм-0,2 мм-0,2 мм-1,05 мм или 1 мм-0,5 мм-1 мм.  

Чтобы установить указанную нерегулярную сетку, необходимо выполнить команду 
Opnions/Grids, в появившемся диалоговом окне (рис. 5.1) в области Grid Spasing ввести 
через пробел выбранные шаги нерегулярной сетки и нажать кнопку Add. Введенная сетка 
зафиксируется в виде отдельной строки в области окна Grids.  

 

Рисунок 5.1- Установка сеток на печатной плате 

2 Установка зазоров между проводниками  
Для разных объектов (для совокупности электрических цепей, для разных участков 

ПП и т. п.) проекта устанавливаются разные правила трассировки и им присваиваются 
различные приоритеты:  



• Class To Class - правила класс-класс (высший приоритет);  

• Net — правила для цепей;  

• Net Class — правила для классов цепей;  

• Global - глобальные правила (низший приоритет).  

Глобальные установки зазоров устанавливаются в меню Options/ Design Rules в 
закладке Design  

Зазоры между различными объектами в различных слоях ПП устанавливаются в 
закладке Layer  

Классы цепей определяют в закладке Net Class команды Options/ Design Rules (рис. 
5.2). Внутри каждого класса устанавливаются допустимые зазоры для пары объектов 
(контактная площадка - проводник, контактная площадка - контактная площадка, 
проводник - проводник и т. п.) и общие правила установки зазоров. Заметим, что 
автотрассирровщик PRO Route использует только глобальные установки зазоров и правила 
трассировки закладки Net меню Options/ Design Rules.  

 

Рисунок 5.2- Окно заданных классов цепей и их атрибутов  

 
 
В окне Net Classes заданы имена классов цепей, а в окне Net Class Rules выведены 

конкретные значения атрибутов для выделенного класса цепей. Значение выделенного 
атрибута может быть изменено после нажатия на кнопку Edit, затем на кнопку Properties и 
вводе в окно Value нужного значения атрибута.  

Для того чтобы ввести Net Class — новый класс цепей (группа цепей, 
использующих одни и те же правила трассировки), щелкните по кнопке Edit Net Classes, 
затем в окне Class Name введите имя нового класса цепей и щелкните кнопку справа Add 
(добавить). Новое имя класса цепей появится в окне Classes.  

Для задания атрибута новому классу цепей проделайте следующие операции. 
Выделите в списке имя нового класса и нажмите кнопку Edit справа от окна Net Class 
Rules. Появится новое окно Attributes. После нажатия на кнопку Add в новом 
появившемся окне Place Attribute выберите категорию атрибута (Attribute Caterory), имя 



атрибута (Name), проставьте значение (Value) атрибута и нажмите ОК. Для изменения 
значения атрибута в окне Attributes нажмите кнопку Properties.  

Добавление новой цепи к выделенному классу производится после выбора одной 
или нескольких (удерживайте клавишу Shift или Ctrl) цепей в поле Unassigned Nets и 
нажатии кнопки Add. Имена выделенных цепей отобразятся в окне Nets in this Class, а в 
поле Unassigned Nets отображается список цепей, не принадлежащих ни к одному из 
классов цепей.  
Классы цепей можно переименовывать (Rename) и удалять (Delete).  

В окне Class Attributes записаны уже сформированные после нажатия кнопки Edit 
Attrs значения атрибутов.  

Кнопка Set Nets From Design Selection позволяет внести в список цепей, 
принадлежащих данному классу, все цепи, выделенные пользователем с помощью команды 
Edit Select на рисунке принципиальной схемы.  

Зазоры для конкретных цепей устанавливаются в закладке Net команды 
Options/Design Rules     (рис. 5.3). Для этого предварительно выбирают курсором имя цепи, 
нажимают кнопку Edit, затем на кнопку Add, в графе Name выделяют имя нужного 
атрибута и в области Value появившегося окна Place Attribute вводят требуемое значение 
зазора.  

Редактирование цепи производится после выделения ее имени в столбце Nets, 
нажатии на кнопку Edit Nets.  

Зазоры между цепями, относящихся к разным классам, устанавливают в закладке 
Class to Class (рис. 5.4). Формирование пары классов производится после выполнения 
следующих операций. Нажимается кнопка Edit Class to Class. В появившемся окне (рис. 
5.5) в двух одноименных строках Net Class Name выбирают имена двух разных классов 
цепей, которые определены ранее, и нажимают кнопку Add Definition. В результате имена 
пары классов появляются в окне Net Class To Net Class Definition. Нужные величины 
зазоров устанавливают в появившемся окне Place Attribute после последовательных 
нажатий на кнопки Edit и Add.  

 

 

Рисунок 5.3- Окно закладки Net команды Options/Design Rules  



 

Рисунок 5.4-Закладка Class to Class команды Options/Design Rules  

 

Рисунок  5.5-  Окно для создания пары классов цепей  

 

3 Задание атрибутов цепям и компонентам  
Атрибуты выбранной цепи устанавливают после выполнения команды Edit/Nets.  В 

диалоговом окне меню можно просмотреть список атрибутов цепи после нажатия на 
кнопку View Attributes или приступить к редактированию атрибутов после нажатия на 
кнопку Edit Attributes. Для добавления или изменения атрибута далее нажимают кнопку 
Add и в открывшемся меню со списком всех стандартных атрибутов (рис. 5.6) в левой 
области Attribute Category выбирают категорию атрибута Net, а в правой области Name 
выбирают имя атрибута. Затем в области Value вводится значение атрибута.  



В окне Attribute Category выводятся списки типов атрибутов для различных 
объектов проекта:  

• All Attributes - список всех стандартных атрибутов;  

• Component - атрибуты компонентов;  

• Net - атрибуты цепей;  

• Clearence - атрибуты допустимых зазоров;  

• Physical — атрибуты физических характеристик;  

 

Рисунок 5.6- Меню редактирования атрибутов  

 

• Electrical - атрибуты электрических характеристик;  

• Placement - атрибуты авторазмещения;  

• Manufacturing - атрибуты улучшения технологичности проекта;  

• Router - атрибуты автотрассировщика PRO Route;  

• Simulation - атрибуты моделирования схемы;  

• SPECCTRA Route — атрибуты автотрассировщика программы SPECCTRA;  

• SPECCTRA Placement — атрибуты авторазмещения программы SPECCTRA.  

Атрибуты компонентов вводятся аналогично после выполнения команды 
Edit/Components, выбора имени компонента, нажатия на кнопку Properties, выбора 
закладки Attributes, последующего нажатия на кнопку Add и ввода в окно Value значения 
атрибута.  



 
4 Ручная трассировка соединений  

 
Перед началом трассировки должны быть установлены на плате все компоненты 

схемы (команда Place/Component), определена(ы) сетка(и) трассировки, слой, в котором 
проводится трасса, ширина проводника и заданы все соединения, т. е. выполнена команда 
Utils/Load Netlist. После выполнения последней команды между контактами 
установленных компонентов на ПП появляются условные линии связей. Если вводится 
новая связь, не указанная в списке соединений, то предварительно, перед трассировкой, 
выполняется команда Place/ Connection, и щелчком мыши вначале указывается первый 
контакт, а затем, не отпуская кнопку мыши, и второй контакт, подлежащие соединению. 
После указания второго контакта появляется окно, в котором пользователь может оставить 
предлагаемое системой имя цепи или изменить это имя и нажать ОК. После указанной 
процедуры появляется условная линия связи между контактами, а затем можно проводить 
связь вручную.  

Ручная трассировка выполняется после команды Route/Manuel или нажатия на 
соответствующую пиктограмму. Трассировка производится только в сигнальных слоях, в 
противном случае появляется сообщение об ошибке. Если необходима перетрассировка уже 
проведенной связи, то эта связь предварительно удаляется.  

Для проведения связи щелчком мыши указывается первый контакт и, не отпуская 
кнопку мыши, рисуют первый сегмент трассы. Отпускание мыши фиксирует излом трассы. 
Для перемещения трассы на один дискрет сетки используются кнопки (при нажатой кнопке 
мыши). Нажатие клавиши О (не отпуская клавишу мыши) дает возможность менять 
характер излома (ортогонально, по диагонали, скругление), а клавиши F — менять 
расположение точки излома. Для создания Т-образных соединений применяется опция T-
Route by Default закладки Route команды Options/Configure.  

При нажатии правой кнопки мыши трасса автоматически завершается по 
кратчайшему пути (заметим, что эта операция практически всегда завершается конфликтом, 
если ранее были уже проведены связи). Клавиши косой черты «\» и «/» прерывают разводку, 
не завершая ее.  

При смене текущего слоя при прокладке трассы нажимают клавишу L, или Shift+L, 
или кнопку строки состояний, при этом переходное отверстие вставляется автоматически. 
Тип переходного отверстия задается командой Options/Via Style.  

При прокладке трассы ширина проводника может быть изменена (в строке 
состояний или по команде Options/Current Line).  

Проведение трассы завершается нажатием на правую кнопку мыши.  
Нарушение установленных зазоров между элементами трасс сопровождается 

звуковым сигналом и появлением на экране вблизи места ошибки индикатора ошибок в 
виде окружности с косым перекрестьем.  

Для последовательного удаления ранее проложенных сегментов трассы вместе с 
возможными индикаторами ошибок используется клавиша Backspace. Полностью 
удаляется последняя трасса командой Edit/ Undo или при нажатии соответствующей 
пиктограммы.  

Сегменты трасс можно удалять или перетрассировать после их выделения и 
применения к ним соответствующих операций по удалению, перетаскиванию или 
перетрассировки.  

В процессе прокладки трассы в строке информации отображаются данные о 
приращении координат текущего сегмента dX и dY (пока нажата левая кнопка), общая 
текущая длина трассы с учетом дуг сглаживания трассы (Total length) и число ошибок по 
завершении прокладки трассы - «"n" error(s) during routing».  



 
5 Интерактивная трассировка соединений  

 

При интерактивной трассировке автоматически выдерживаются установленные 
зазоры и автоматически огибаются препятствия. Интерактивная трассировка выполняется 
по команде Route/Interactive или после нажатия на соответствующую пиктограмму. 
Трассировка начинается щелчком курсора на выводе компонента и дальнейшем поточечном 
проведении сегментов трасс, или вторым щелчком указывается второй вывод компонента, 
подлежащий соединению с первым указанным выводом. При поточечной прокладке трассы 
будут звучать сигналы, информирующие о недопустимости нарушения зазоров при 
приближении трассы к другим цепям, контактам компонента или к переходным 
отверстиям. После нажатия правой кнопки мыши появляется меню для трассировки в 
интерактивном режиме:  

• Complete — завершение прокладки трассы с соблюдением установленный ранее 
правил трассировки и соблюдением установленных зазоров;  

• Suspend — прекращение прокладки трассы (трасса остается незавершенной);  

• Cancel - прекращает трассировку и отменяет ввод последнего сегмента трассы;  

• Options - активизирует закладку Route меню Options/Configure для возможных 
изменений опций трассировки;  

• Layers — запускает команду Options/Layers для изменения структуры слоев платы;  

• Via Style - запускает команду Via Style для выбора стиля переходного отверстия или 
его редактирования;  

• Unwind - отменяет прокладку последнего сегмента проводника (то же самое, что и 
использование клавиши Backspace).  

Клавиши О, F, "\", "/" , а также имеют те же назначения, что и при ручной 
трассировке, однако при интерактивной трассировке не производится скругление трассы по 
дуге.  

Если произвести два последовательных щелчка вначале по первому, а затем по 
второму контакту, то трасса между ними будет проведена автоматически по кратчайшему 
пути с соблюдением всех правил трассировки и автоматическим переходом (если 
программа посчитает нужным это сделать) из слоя в слой.  

При пересечении трассы металлизированного экрана в нем будут автоматически 
вырезаться каналы с соблюдением заданных ранее зазоров.  

Утилита P-CAD InterRoute Gold — дополнительное средство для интерактивной 
трассировки электрических связей. В нее входят пять команд, имеющих соответствующие 
пиктограммы, вынесенные на панель инструментов Route Toolbar: Route Fanout, Route 
Bus, Rute MultiTrace, Push Traces и Visible Routing Area.  

Команда Route/Fanout производит трассировку жгута (группы трасс) от группы 
контактных площадок. Команда генерирует короткие выравнивающие отрезки 
проводников, концы которых располагаются на одной прямой — для удобства дальнейшей 
трассировки соединений. Утилита может запускаться после нажатия соответствующей 
пиктограммы. Затем при нажатой клавише Ctrl отмечаются контактные площадки, от 
которых будет начинаться жгут. Щелчком правой кнопки мыши вызывается контекстное 
меню команды. В контекстном меню строка Deselect All отменяет выбор контактных 
площадок, строка Layers вызывает меню Options/Layers, строка Options - команду 



Options/Configure. В меню выбирается строка Fanout. В результате появляется диалоговое 
окно команды (рис. 5.7).  

 

Рисунок  5.7- Организация трассировки жгута соединений  

В этом окне выбираются стиль и параметры выравнивающих отрезков проводнков. 
Если выбранные контактные площадки лежат на одной прямой или выбрана одна 
контактная площадка, то появляются соответствующие текстовые сообщения.  

В меню Select Fanout в зоне Fanout Style выбирается стиль выравнивающих 
отрезков, которые отображаются в окне Preview. Установленный флажок Space Traces at 
Minimum Clearance означает выравнивание отрезков проводников с минимальным зазором 
между ними, определяемым шагом выбранной сетки трассировки.  

Кнопки меню Flip/Flop в правом нижнем углу диалогового окна позволяют выбрать 
ориентацию выравнивающих отрезков.  

Команда Route/Bus используется, как правило, совместно с предыдущей командой и 
позволяет трассировать одновременно несколько проводников, которые образуют шину. 
Запуск команды может производиться при нажатии на соответствующую пиктограмму. 
Затем, при нажатой клавише Ctrl, производится выбор контактных площадок или концов 
параллельных проводников, построенных предыдущей командой. Далее при нажатой левой 
кнопке мыши трассируются одновременно несколько проводников (область трассировки 
при этом подкрашивается). Заметим, что при трассировке нельзя изменить слой прокладки 
трассы. Нажатие правой кнопки мыши вызывает контекстное меню, в котором выбор 
строки Suspend приостанавливает прокладку трасс, оставляя ее незавершенной. Строка 
Cancel стирает последний сегмент трассы и прекращает трассировку. Строка Unwind 
стирает последний сегмент проводника.  

Команда Route/MultiTr асе позволяет автоматически развести одновременно 
несколько выбранных цепей с соблюдением установленных правил трассировки. При этом 
может использоваться либо режим максимального огибания проводников (Maximum 
Hugging), либо режим минимизации их длины (Minimum Length). Эти режимы 
включаются соответствующими пиктограммами или в закладке меню Options/ Configure. 
Для выполнения команды вначале указывают несколько цепей одинаковой ширины и 
нажимают правую кнопку мыши. В контекстном меню выбирается строка Complete для 
автоматического проведения выбранных цепей.  

Команда Push Traces обеспечивает режим трассировки с раздвиганием соседних 
проводников (но не контактных площадок и переходных отверстий!). Указанный режим 



работает со всеми командами интерактивной трассировки. Включается при нажатии 
соответствующей пиктограммы Push Traces.  
Команда Visible Routing Area определяет пространство на плате, наиболее удобное для 
трассировки конкретной цепи. Должен быть включен режим интерактивной трассировки. 
Вначале активизируется соответствующая пиктограмма. Затем выделяется нужная 
электрическая цепь, и вычерчивается трасса в подкрашенной области. Для автоматической 
трассировки выбранной цепи выбирается строка контекстного меню Complete.  
 

6 Автотрассировщик Quick Route 
 
Автотрассировщик запускается из графического редактора P-CAD РСВ с помощью 

меню Route/Autorouters. Диалоговое окно автотрассировщика Quick Route показано на 
рис.5.8  

Автотрассировщик не требует указания границы печатной платы в слое Board и не 
изменяет топологию предварительно проложенных пользователем проводников. 
Предварительно на плате должны быть размещены все компоненты, определены все 
электрические связи. Некоторые связи могут быть уже проведены. Можно задать области 
запрета для трассировки по команде Place/KeepOut.  

В области Strategy диалогового окна находятся следующие кнопки:  

• Strategy File - файл стратегии трассировки, т. е. совокупность параметров для 
трассировки (расширение файла - .STR). По умолчанию имеет имя входного файла;  

• Output PCB File - файл с записью результатов трассировки (расширение файла 
* .РСВ). По умолчанию имеет имя входного файла, но перед именем файла 
добавляется буква R;  

• Output Log File - текстовый отчет о результатах трассировки (расширение файла 
* .LOG). По умолчанию имеет имя входного файла, но перед именем файла 
добавляется буква R.  

Кнопка Load загружает готовый файл стратегии. Кнопка Save сохраняет выбранный 
файл стратегии для текущего проекта. Кнопка Set Base устанавливает параметры стратегии 
и имена перечисленных выше трех файлов по умолчанию.  

Кнопка Layers вызывает для проверки или возможных изменений диалоговое окно 
Options Layers.  
Кнопка Net Attrs вызывает диалоговое окно Edit Nets для просмотра и редактирования 
атрибутов цепей или редактирования атрибутов.  

Кнопка Via Style вызывает диалоговое окно Options Via Style для просмотра и 
редактирования стеков контактных площадок. Переходные отверстия, которые всегда 
располагаются в узлах сетки трассировки, для различных цепей можно задавать с помощью 
атрибута VIASTYLE. Максимальный диаметр переходного отверстия ограничен двумя 
шагами сетки трассировки.  

После нажатия на кнопку Passes в диалоговом окне Pass Selection (рис. 5.9) 
простановкой соответствующих флажков выбираются типы проходов трассировки.  

Wide Line Routing - автотрассировщик производит разводку в первую очередь 
«широких» цепей, имеющих атрибуты AUTOROUTEWIDE и WIDTH. Разводка 
производится только в горизонтальном и вертикальном направлениях. Наклонные трассы 
проводятся вручную, и при дальнейшем запуске QuickBoute ширина таких трасс 
трассировщиком не изменяется.  

 



 

Рисунок  5.8- Окно автотрассировщика Quick Route  

 

 

 

Рисунок  5.9- Окно выбора шагов трассировки  

 

 



Вначале рекомендуется запустить автотрассировщик (рис. 5.10) только при активном 
проходе Wide Line Routing (другие проходы должны быть запрещены). Если не выполнена 
трассировка «широких» трасс, то доводка трасс производится вручную. Трассировщик 
можно запускать несколько раз с активизацией всех проходов, за исключением двух 
оптимизирующих - Route Cleanup и Via Minimisazion.  

Horizontal — трассировка простых трасс только горизонтальными линиями без 
переходных отверстий с минимальными, отклонениями от горизонтальной линии.  

Vertical — трассировка простых трасс только вертикальными линиями без 
переходных отверстий с минимальными отклонениями от вертикальной линии.  

"L" Routes ( 1 via) - формирование фрагментов цепи, имеющих два проводника 
(вертикальный и горизонтальный), расположенных в двух разных слоях и соединяемых 
переходным отверстием. Такая конфигурация имеет вид буквы L с различной ее 
ориентацией. Проводники размещаются на расстоянии не более 100 mil (2,5 мм) от сторон 
прямоугольника, вершины которого расположены в центре двух соединяемых трассой 
контактных площадок. Если противоположные слои плать$нимеют ориентацию трассы 
отличную от ортогональной, то данный проход не используется.  

"Z" Routes (2 vias) — формирование фрагментов цепи, имеющих три проводника 
(вертикальные и горизонтальные), расположенных в двух разных слоях и соединяемых 
двумя переходными отверстиями. Такая конфигурация имеет вид буквы Z с различной ее 
ориентацией. Проводники размещаются на расстоянии не более 100 mil (2,5 мм) от сторон 
прямоугольника, вершины которого расположены в центре двух соединяемых трассой 
контактных площадок. Если противоположные слои платы имеют ориентацию трассы 
отличную от ортогональной, то данный проход не используется.  

"С" Routes (2 vias) - формирование фрагментов цепи, имеющих три проводника 
(вертикальные и горизонтальные), расположенных в двух разных слоях и соединяемых 
двумя переходными отверстиями. Такая конфигурация имеет вид буквы С с различной ее 
ориентацией. Проводники размещаются на расстоянии более чем 100 mil (2,5 мм) от сторон 
прямоугольника, вершины которого расположены в центре двух соединяемых трассой 
контактных площадок.  

Any Node (2 vias) - попытка трассировки.связи между двумя контактными 
площадками с введением не более чем двух переходных отверстий с целью выполнения 
наиболее полной трассировки схемы. При этом оптимизация (минимизация) длины трассы, 
в отличие от предыдущих проходов, не производится.  

Maze Routes - оптимизирующая «лабиринтная» трассировка, не имеющая 
ограничений на ориентацию проводников на слое. Нет ограничений и на число переходных 
отверстий. Максимальное число переходных отверстий для одной цепи устанавливается 
атрибутом MAXVIAS (по умолчанию число переходных отверстий для одной. трассы равно 
10). Поскольку лабиринтная трассировка уменьшает число свободных каналов для разводки 
остальных цепей, то рекомендуется вначале сделать разводку при выключенном проходе 
Maze Routes, затем провести ручную разводку сложных участков платы, а затем вновь 
запустить трассировку при включенном проходе Maze Routes.  

Any Node (maze) - «лабиринтная» трассировка без оптимизации длины трассы, с 
целью попытки проведения трассы «любой ценой».  

Route Cleanup - используется для улучшения «внешнего вида» печатной платы 
путем спрямления уже проведенных трасс. Проход используется после завершения 
разводки всех электрических цепей.  



Via Minimisazion — уменьшает число переходных отверстий на разведенной плате.  

Последние два прохода рекомендуется использовать совместно после полного 
завершения трассировки.  

 

 

 

Рисунок  5.10- Окно трассировщика Quick Route  

 
В строке Routing Grid окна Route Autorouters определяется сетка трассировки из 

четырех возможных значений шагов трассировки: 25 mil, 20 mil, 16,7 -16,6 - 16,7 mil (для 
нерегулярной сетки) и 12,5 mil. Другие значения шагов трассировки, включая и 
метрическую систему единиц, запрещены.  

В строке Line Width  выбирается ширина всех проводников. Минимальное значение 
ширины - 0,1 mil (0,01 мм - в метрической системе). Максимальное значение ширины 
проводников ограничено выбранным шагом сетки трассировки. Если необходимо задать 
ширину отдельного проводника, то она определяется при выполнении команды Edit/Nets 
заданием атрибута WIDTH .  

Область переключателя Error Messages позволяет вывести сообщения об ошибках 
на экран монитора (Output to Screen), в файл диагностики (Output to Log File) или как в 
файл, так и на экран (Output to Both).  



Команда Route/Info выводит текущую информацию о ходе трассировки (рис. 5.11).  
Команда Route/Cancel прекращает процесс трассировки, а пользователь должен сделать 
выбор — временно прекратить трассировку и запомнить промежуточные результаты 
(Stop Routing and Save), или прекратить трассировку без сохранения результатов (Cancel 
Routing and do not save).  

После нажатия на кнопку Start процесс разводки цепей визуализируется на экране, а 
в строке состояний выводятся сообщения о ходе трассировки.  

После окончания трассировки в файле-протоколе .LOG формируется информация о 
результатах выполнения отдельных шагов трассировки и итоговые данные.  

 

  

Рисунок  5.11- Окно текущей информации о ходе трассировки  

Пример файла приведен в приложении 1  P-CAD 2000 РСВ Version 15.10.17 Routing 
Log File ). 

Ограничения для QuickRoute:  

• Используются только простые контактные площадки и переходные отверстия, 
имеющие одну и ту же форму на всех слоях;  

• Для цепей, не имеющих атрибута AUTOROUTEWIDE, допускается только один 
стиль переходных отверстий;  

• Широкие цепи, разводимые на проходе Wide Line Routing, должны иметь атрибуты 
VIASTYLE, WIDTH и AUTOROUTEWIDE. Значения ширины проводника и стили 
переходных отверстий устанавливаются разными для каждой широкой цепи;  

• Диаметр переходного отверстия не должен превышать двойного размера текущей 
сетки трассировки;  

• Метрическая сетка трассировки не разрешается, а разрешенные сетки трассировки 
могут иметь шаги 10 мил, 12,5 мил, 16,7-16,6-16,7 мил, 20 мил и 25 мил; "V  

• Ширина проводника не должна превышать половину шага текущей сетки;  

• Атрибут RIPUP трассировщиком не поддерживается;  



• Атрибут MAXVIAS используется только при разводке типа «лабиринт»;  

• Для переходных отверстий специальную сетку создать нельзя;  

• Выводы компонентов разрешено поворачивать только на 90°;  

• Допускается не более четырех слоев металлизации.  

 

7 Автотрассировщик Pro Route  
 

Автотрассировщик ProRoute позволяет трассировать без ограничения числа 
выводов компонентов проекта до 30 сигнальных слоев и до 99 слоев металлизации на 
печатной плате.  

Так же как и в предыдущем случае автотрассировки, должна быть загружена плата с 
размещенными на ней компонентами и указаны связи между выводами компонентов. В 
слое Board должна быть указана область трассировки в виде контура и, в случае 
необходимости, барьеры для трассировки. Некоторые компоненты должны быть 
зафиксированы (разъемы, элементы питания и т. п.). Если вручную проведены некоторые 
электрические связи («земля», питание и др.), и они должны быть сохранены в процессе 
автотрассировки, то эти связи должны иметь атрибут NoAutoRoute.  

Кнопка Design Rules вызывает команду Options/Layers для установления зазоров 
между объектами на ПП. Доступны в этом случае только две закладки появляющегося 
меню - Layer и Net.  

Кнопка Layers вызывает для проверки или возможных изменений диалоговое окно 
Options Layers.  

Кнопка Net Attrs вызывает диалоговое окно Edit Nets для просмотра и 
редактирования атрибутов цепей или редактирования атрибутов.  

Кнопка Line Width открывает окно Options Current Line, в котором можно 
установить ширину проводников.  

Кнопка Route Grid предназначена для задания (при выключенном флажке Auto 
Grid) вручную сетки трассировки.  

Кнопка Via Style вызывает окно команды Options/Via Style, в котором можно 
редактировать как простые, так и сложные стеки контактных площадок.  

Нажатие кнопки Passes вызывает окно для выбора проходов трассировки (рис. 5.13).  

Настройка проходов производится при сброшенном флажке Auto pass selection 
(автоматический выбор проходов).  

В области Manual Pass Selection все устанавливаемые пользователем проходы 
делятся на три группы:  

• Первую группу — группу «непосредственной трассировки» (Constructive) образуют 
проходы Wide Via Fanout (SMD), Via Fanout (SMD), Wide Initial, Wide 
Comprehensive, Memory, Initial, Comprehensive, Exhaustive. При выполнении этих 
проходов не происходит перетрассировка уже проложенных цепей. Новые трассы 
прокладываются в свободных местах поля трассировки ПП.  

• Вторую группу — группу «трассировки с перекраиванием ранее проложенных 
соединений» (Iterative) образует один проход Iterative (Rip-up). В этом режиме 
трассировки возможны разрывы и перетрассировка ранее проложенных цепей.  

• Третью группу - группу «улучшения внешнего вида и технологичности платы» 
(Manufacturing Imrovement) образуют проходы  

 



 

Рисунок 5.12 - Окно настроек трассировщика Pro Route  

 

 

Рисунок 5.13- Окно выбора проходов трассировки  

Manufacturing и Final Manufacturing. Эти проходы улучшают внешний вид платы 
за счет спрямления углов проводников, удаления лишних переходных отверстий и т. п.  



Рассмотрим функции каждого из проходов.  

Wide Via Fanout (SMD) — обеспечивает для планарных контактов прокладку 
коротких широких отрезков трасс с переходным отверстием (fanout, stringer) на конце 
таких линий. Переходное отверстие подсоединяется к широкой цепи (питание, общая 
шина). Эти цепи должны иметь атрибуты WIDTH и AUTOROUTEWIDE.  

Via Fanout (SMD) - формирование коротких отрезков трасс (stringer) стандартной 
ширины с переходным отверстием на конце отрезка для всех планарных контактов.  

Wide Initial - трассировка широких цепей (питание, общая шина) с числом 
переходных отверстий не более трех. Эти цепи должны иметь атрибуты WIDTH и 
AUTOROUTEWIDE.  

Wide Comprehensive — трассировка широких цепей (питание, общая шина) без 
ограничения числа переходных отверстий. Эти цепи должны иметь атрибуты WIDTH и 
AUTOROUTEWIDE.  

Memory — трассировка с подключением шин данных к микросхемам памяти. 
Трассы проводятся в одном слое и с минимальными смещениями по горизонтали или по 
вертикали (не более 100 mils или одного шага сетки).  

Initial - выполнение простых соединений стандартней ширины с числом переходных 
отверстий не более трех. При этом строго учитывается направление проводников на слое и 
не разрешается разводка по диагонали.  

Comprehensive — проход применяется для более сложных трасс, требующих не 
более шести переходных отверстий. Трассы прокладываются без учета приоритетного 
направления прокладки трассы на данном слое.  

Exhaustive - трассировка наиболее сложных трасс. Все ограничения (за 
исключением расстояний между элементами трассы электрической цепи) снимаются.  

Iterative (Rip-up) — основной итерационный алгоритм прокладки трасс. Алгоритм 
позволяет разрывать проложенные ранее трассы, перекраивать их с целью улучшения 
условий для разводки следующих цепей. Предусмотрено два типа итеративных проходов: 
локальные и глобальные разрывы цепей Rip-up. Вначале применяются глобальные 
проходы. При этом модифицируются все трассы на плате. Локальное перекраивание цепей 
производится на отдельных участках печатной платы при достижении 98%-ной разводки 
или после завершения трех глобальных проходов. Проход Iterative (rip up) допускает 
простановку произвольного количества переходных отверстий и любые направления трасс 
на слоях трассировки. Нужное число проходов (до десяти) устанавливается в окне Max 
Iterative Passes области Pass Counts диалогового окна Pass Selection.  

Проход Manufacturing оптимизирует результаты трассировки для обеспечения 
технологичности изготовления печатной платы. При этом производится уменьшение длины 
соединений за счет спрямления трасс, удаляются избыточные переходные отверстия, 
увеличиваются расстояния между проводниками (за счет переноса фрагментов трасс на 
другие слои) и т. п. Нужное число проходов (допускается до десяти) устанавливается в окне 
Manufacturing Passes области Pass Counts диалогового окна Pass Selection. Данный 
проход не увеличивает число разведенных связей.  

Проход Final Manufacturing завершает работы по улучшению технологичности 
изготовления печатной платы и улучшению ее вида. В частности, если разрешена 
диагональная трассировка, то прямоугольные изломы трассы могут быть заменены 
диагональными фрагментами.  

Проходы группы Manufacturing выполняются только после 100%-ной трассировки.  



Флажок Auto pass selection разрешает автотрассировщику выбирать проходы 
автоматически, сообразуясь с особенностями печатной платы. Только при выключенном 
флажке Auto pass selection пользователь может устанавливать по своему усмотрению виды 
проходов трассировки.  

При включении флажка Force Manufacturing Pass оптимизация технологичности 
платы включается независимо от завершенности трассировки платы.  

Вернемся к окну Route Autorouters. Область Options содержит флажки, 
позволяющие включать/выключать параметры, влияющие на трассировку печатной платы:  

• флажок Auto Grid разрешает автотрассировщику Pro Router выбрать оптимальную 
сетку трассировки. Этот выбор основан на анализе программой характеристик платы 
и заданных правилах трассировки. При включенном флажке Auto Grid заданная 
пользователем сетка трассировки игнорируется;  

• флажок Ripup разрешает в процессе трассировки разрывать ранее проведенные 
трассы и прокладывать их вновь при выполнении проходов Iterative и 
Manufacturing. Если же не надо менять ранее проведенные соединения, то у этих 
соединений должен быть установлен атрибут NoAutoRoute. Опция Ripup не 
уменьшает число проведенных трасс, и ее рекомендуется включать всегда для 
наиболее эффективной прокладки соединений;  

• флажек Diagonals разрешает трассировку под углом 45°. Однако при наличии 
планарных контактов и насыщенной компонентами печатной платы такая 
трассировка уменьшает количество разведенных цепей. Поэтому рекомендуется 
вначале выключить данную опцию и выполнить проход Iterative. После завершения 
100%-ной трассировки можно включить опцию Diagonals и отработать проходы 
Manufacturing для улучшения внешнего вида печатной платы;  

• флажок Simultaneous Class Routing включает режим одновременной трассировки 
цепей, относящихся к разным классам (которые формирует сам пользователь). При 
сброшенном флажке цепи с высоким приоритетом проводятся в первую очередь и 
могут заблокировать проводку остальных цепей, имеющих более низкий приоритет. 
Поэтому при начальной трассировке этот флажок должен быть включен. 
Одновременная трассировка цепей требует достаточно больших объемов памяти, а 
сама трассировка занимает длительный отрезок времени;  

• число, проставленное в окне Checkpoint Interval Minutes позволяет установить 
интервал времени в минутах между моментами сохранения файла результатов 
трассировки (расширение файла .СРТ). В любом случае результаты трассировки 
сохраняются в этом файле после каждого прохода трассировки и по желанию 
пользователя после выдачи им команды Route/Cancel.  

В области Copper Share устанавливаются опции разрешения/запрета для 
использования Т-образных фрагментов трасс:  

• опция Lines and vias разрешает Т-образное соединение с ближайшими контактной 
площадкой, с переходным отверстием или с любым фрагментом одной и той же 
цепи;  

• опция Vias only разрешает Т-образное соединение только с ближайшими 
переходным отверстием или контактной площадкой той же цепи;  

• опция Disable разрешает Т-образные соединения только с ближайшей контактной 
площадкой.  



Область переключателя Error Messages позволяет вывести сообщения об ошибках 
на экран монитора (Output to Screen), в файл диагностики (Output to Log File) или как в 
файл, так и на экран (Output to Both).  

Запуск автотрассировщика Pro Route производится после нажатия на кнопку Start.  
Процесс трассировки возобновляется (если до этого он был прерван) после нажатия 

на кнопку Restart.  
Для прекращения трассировки и управления ее ходом используется команда 

Route/Cancel, в окне которой (рис. 5.14) можно выбрать варианты завершения или 
продолжения трассировки.  

 

 

Рисунок  5.14- Меню команды Route Cancel  

 

Stop routing and save - прекратить трассировку и записать промежуточные результаты.  

Stop routing and do not save — прекратить трассировку, промежуточные результаты не 
записывать. В этом случае файл *.СРТ будет удален.  

Stop routing at end of this pass - прекратить трассировку после завершения текущего 
прохода и сохранить результаты.  

Skip this pass and continue — пропустить текущий проход и приступить к выполнению 
следующего прохода.  

Checkpoint route and continue - немедленно создать файл текущих результатов *.СРТ и 
продолжить трассировку. Suspend route - создать файл *.СРТ и прекратить трассировку. 
Протокол и результаты трассировки сохраняются в файле *.LOG. 

 

8 Бессеточный трассировщик P-CAD Shape-Based Router  
 

Автотрассировщик предназначен для интерактивной и автоматической трассировки 
многослойных печатных плат с высокой плотностью размещения компонентов. Особенно 
эффективен для компонентов с планарными контактами, выполненных в разных системах 
единиц измерения. Автотрассировщик обрабатывает печатные платы, имеющих до 30 
слоев, до 4000 компонентов, до 5000 контактов в одном компоненте до 1000 цепей и до 16 
000 электрических соединений в проекте.  

Запускается программа или непосредственно из редактора P-CAD РСВ или автономно из 
среды WINDOWS (файл SR.EXE).  



 

8.1 Настройка стратегии трассировки  
 

Настройка стратегии трассировщика производится после его запуска с помощью 
диалогового окна Options/Auto-Router (рис. 5.15).  

Диалоговое окно имеет три закладки: Routing Passes, Parameters и Testpoints.  
В закладке Routing Passes в областях Router Passes и Manufacturing Passes 

устанавливаются различные процедуры (проходы) трассировки:  

 

Рисунок 5.15- Настройка стратегии трассировки  

Memory (память) — трассирует модули типа «память» в одном, горизонтальном или 
вертикальном, направлении. Используются эвристические (Heuristic) или регулярные 
методы поиска (Search). Эту процедуру рекомендуется включать всегда, даже в том случае, 
если даже нет схем «памяти».  

Fan Out Used SMD Pins (веер) - эта процедура позволяет генерировать веерообразное 
расположение стрингеров контактных площадок компонентов. Неудачные места 
расположения стрингеров помечаются на экране небольшой окружностью желтого цвета с 
символом X в центре окружности. Процедура используется при наличии пленарных 
выводов компонентов на верхнем, нижнем или обеих сторонах печатной платы. 
Рекомендуется провести данную процедуру для предварительной трассировки, и если 
примерно 10% стрингеров не будут сформированы, то компоненты необходимо 
переразместить.  

Pattern (шаблон) — использование стандартных шаблонов (алгоритмов) трассировки, 
имеющихся в программе. Рекомендуется данный проход включать всегда.  

Shape Router - Push and Shove (вставка и расталкивание) - является основным 
алгоритмом трассировки. При вставке проводников соседние проводники раздвигаются по 
диагонали без ограничения расстояния при раздвижке проводников. Возможно 
«перескакивание» проводников через переходные отверстия и контактные площадки.  



Shape Router - Rip Up (разрыв) - после выполнения процедуры Push and Shove еще 
возможны некоторые конфликты между проведенными цепями (помечаются небольшими 
окружностями желтого цвета). Данная процедура принудительно разрывает уже 
проложенные цепи и прокладывает их заново с целью ликвидации таких конфликтов.  

Clean During Routing - спрямление проводников в процессе трассировки.  

Clean After Routing - спрямление проводников после окончания трассировки.  

Evenly Space Traces — раздвижка проводников с целью более равномерного заполнения 
ими всей площади печатной платы.  

Add Testpoints - разрешение на вставку контрольных точек электрических цепей согласно 
установкам, сделанным во вкладке Testpoints.  

В окне Routed Corners закладки Routing Passes устанавливается допустимое значение угла 
изломов проводников — 45° или 90°.  

В закладке Parameters (рис. 5.16) устанавливаются параметры трассировки для различных 
слоев платы.  

 

Рисунок 5.16- Установка параметров автотрассировщика 

В заголовке Layer перечислены доступные слои трассировки, а справа от имени слоя 
можно установить предпочтительную ориентацию проводников на этом слое.  

• Auto - ориентация проводников выбирается автоматически после нажатия на кнопку 
Analyze Directions.  

• Disabled - запрет трассировки.  

• Fan Out — генерация стрингеров в виде веера.  

• Plane - внутренний слой металлизации.  



• Vertical  - вертикальная ориентация проводников.  

• Horizontal - горизонтальная ориентация проводников.  

• Any Direction - любое направление проводников при трассировке.  

• Angled Direction per Layer - предпочтительная ориентация проводников под 
разными углами 45/, 45\\, 1 o'clock, 2 o'clock, 4 o'clock, 5 o'clock. Такая ориентация 
может назначаться для всех слоев печатной платы. На практике для верхнего и 
нижнего слоев задаются либо горизонтальная, либо вертикальная ориентация 
проводников.  

В окнах закладки Parameters задаются следующие параметры.  

• Units - выбор системы единиц измерения.  

• Via Type — запрет или разрешение для ввода переходных отверстий ( No Vias, 
Thruhole Only).  

• Channel — установка ширины канала трассировки (ширина трассы плюс величина 
зазора). Оптимальное значение параметра вычисляется системой, но значение может 
быть установлено и пользователем (выбор из десяти значений предлагается 
системой). Для выбора бессеточного алгоритма трассировки ширина канала 
выбирается равной Шил и менее.  

• Vias under SMD — запрет(No) или разрешение (Yes) размещения переходных 
отверстий под планарными контактными площадками.  

• Primary Pad Size — установка диаметра наиболее типичных штыревых контактных 
площадок.  

• Primary Via Width - установка диаметра наиболее типичных переходных отверстий.  

• Primary Trace Width - диаметр текущего переходного отверстия, установленного в 
графическом редакторе.  

• Primary Clearance — типичный зазор между объектами на печатной плате.  

В закладке Testpoints (рис. 5.17) задаются параметры генерации контрольных точек 
электрических цепей, в качестве которых могут использоваться существующие контактные 
площадки и переходные отверстия, появившиеся в результате трассировки. Можно 
добавлять площадки контрольных точек для тех цепей, которые не имеют таких точек или 
переходных отверстий. Напомним, что для автоматической генерации контрольных точек 
на закладке Routing Passes (рис. 5.8) должен быть включен флажок Add Testpoints.  

Параметры закладки Testpoints следующие.  

• Existing Via - существующие переходные отверстия.  

• Component Pad (Bottom Only) — контактные площадки (только на нижней стороне 
печатной платы).  

• Testpoint Pad (Top Only) - ранее вставленные программой трассировки 
контрольные точки (только на верхней стороне платы).  

• Testpoint Pad (Bottom Only) — ранее вставленные программой трассировки 
контрольные точки (только на нижней стороне платы).  



• Testpoint Pad (Thruhole) - ранее вставленные программой трассировки сквозные 
контрольные точки.  

• Testpoint Grid — шаг сетки, в узлах которой размещаются контрольные точки.  

• Testpoint Reference Designator - префикс позиционных обозначений контрольных 
точек ((Testpoint, TP,T).  

• Lockdown existing used testpoints - разрешение пользовать контрольные точки, 
которые созданы в предыдущем сеансе трассировки.  

Для каждой электрической цепи можно задать индивидуальный набор атрибутов, 
который будет использоваться при автотрассировке. Нужные атрибуты цепей 
устанавливаются в окне Net Attributes, которое вызывается командой Edit/Net Attributes 
(рис. 5.18).  

В этом окне можно задать:  

• Display - режим отображения цепи на экран (True/False);  

• Priority — очередность автотрассировки цепей (до 20 цепей);  

• Length Minimize - режим минимизации длины конкретной цепи: None - нет 
требований к длине цепи, Min Dist - минимизация общей длины цепи, Daisy — 
сохранение последовательного соединения контактных площадок (стиль Daisy-
chain), Horizontal — горизонтальная прокладка цепи (обычно используется для 
цепей «питание» и «земля», Vertical - вертикальная прокладка цепи (обычно 
используется для цепей «питание» и «земля»);  

 

 

Рисунок 5.17 - Параметры генерации контрольных точек электрических цепей  



 

Рисунок 5.18 - Установка атрибутов электрических цепей  

• Route Action — стиль автотрассировки: Default — стандартный стиль 
автотрассировки (если печатная плата двухслойная, то стрингеры создаются только 
для планарных контактных площадок), Route — трассировка цепи без генерации 
стрингеров, No Route - запрет трассировки цепи, Locked - запрет перетрассировки 
ранее проложенной цепи, Fan Out/Route - предварительная генерация стрингеров 
для планарных контактных площадок (если таковые имеются) выбранной цепи, а 
затем ее трассировка, Fan Out/Plane -предварительная генерация стрингеров для 
планарных контактных площадок (если таковые имеются) выбранной цепи, без ее 
трассировки (для слоев «земли» и «питания»);  

• Route Layers - выбор слоев трассировки для конкретной цепи: Аll Routing - 
трассировка на всех сигнальных слоях, Тор - трассировка только на верхнем слое, 
Bottom - трассировка только на нижнем слое;  

• Width - ширина трассы конкретной цепи (по умолчанию всем трассам назначается 
ширина, определенная в поле Primery Trace Width закладки Parameters окна 
Autorouter Setup).  

Для быстрого поиска нужной цепи в окне Find Net диалогового окна Net Attributes 
можно указать имя (номер) этой цепи.  

Перед началом трассировки рекомендуется выполнить команду Reports/Pre-Route 
Synopsis, которая кратко информирует о возможных будущих результатах трассировки 
(файл SR.RPT). При анализе файла пользователь принимает решение о начале трассировки 
или о частичном изменении параметров стратегии трассировки или параметров печатной 
платы.  

По команде View/Density можно получить цветную графическую карту плотности 
трассировки печатной платы. На этой карте красным цветом обозначена наибольшая 
плотность трасс, голубым — наименьшая плотность. Если на печатной плате одно или 
несколько пятен красного цвета, занимающие более 10-20% площади печатной платы, то 
для успешной трассировки рекомендуется переразместить компоненты.  



 
9 Ручная трассировка  

 
Ручная трассировка новых соединений или редактирование существующих трасс 

производится после выполнения команды Tools/ Manual route. Перед началом работы на 
печатной плате должны быть размещены компоненты и определены соединения между 
контактами компонентов по команде Place/Connection или загружена полученная ранее 
информация о соединениях командой Utils/Load Netlist. Необходимо проверить также 
наличие всех слоев для трассировки (в противном случае необходимо выполнить команду 
Options/Layers и настроить слои трассировки). Трассировка производится только в 
сигнальных слоях. При попытке использовать для трассировки несигнальные слои 
появляется сообщение об ошибке.  

Трасса на печатной плате фиксируется щелчками левой кнопки мыши в местах начала 
трассы, ее изломов и конца трассы. В случае нарушения допустимых зазоров между 
объектами на печатной плате ошибка помечается маркерами (кружками) желтого цвета.  

Переход трассы из одного слоя на другой с автоматической вставкой переходного 

отверстия производится нажатием на клавишу номера сигнального слоя. Клавиша L 

позволяет переключать сигнальные слои.  

Для удаления последнего сегмента трассы в контекстном меню нажимается строчка 
Undo.  

Если нужно прервать трассировку в том месте, где находится курсор (при нажатой 
левой клавиши мыши), можно воспользоваться клавишей / (прямой слэш). Эта клавиша 
либо прерывает прокладку трассы, либо показывает кратчайший путь от прерванного места 
до контакта. Этот кратчайший путь называется оптимизацией частично выполненной 
трассировки, и этот режим включается флажком Optimize Partial Route команды 
Options/Configure.  

В процессе выполнения ручной трассировки после нажатия на правую кнопку мыши 
появляется контекстное меню, которое позволяет выполнить следующие операции:  

• Exit - завершение прокладки трассы (трасса остается неразведенной);  

• Finish — автоматическое завершение трассы программой;  

• Lock - прекращение прокладки трассы (трасса остается недоразведенной).  

10  Интерактивная трассировка  

Интерактивная трассировка выполняется с помощью набора команд меню Tools.  

• Autorowte Connection (автоматическая трассировка одного соединения) — 
пользователь последовательно, цепь за цепью, указывает порядок трассировки 
соединений.  

• Autoroute Net (автоматическая трассировка одной цепи) — после выбора нужной 
цепи будет произведена ее трассировка с соблюдением всех обусловленных ранее 
ограничений на трассировку указанной цепи.  

• Autoroute Component (автоматическая трассировка всех связей компонента) — 
выбор компонента производится указанием мышью на один из его выводов. Затем 
автоматически проводятся все цепи, инцидентные всем контактам выбранного 
компонента.  



• Autoroute Area (автоматическая трассировка в выбранной области) — необходимо 
очертить область печатной платы, после чего все соединения, начинающиеся или 
заканчивающиеся в этой области, будут проведены автоматически.  

Для соединения контактов надо щелкнуть по контакту (или по электрической связи, 
проложенной ранее), к которому подходит нужная связь. От контакта к контакту будет 
проложена трасса с возможными переходами из слоя в слой.  

При интерактивной трассировке выполняются заданные атрибуты цепей:  

• WIDTH - ширина трассы;  

• VIASTYLE — стиль переходного отверстия;  

• CLEARANCE - величина любого зазора;  

• PADTOPADCLEARANCE — зазор между контактами компонента;  

• PADTOLINECLEARANCE - зазор между контактом и линией трассы;  

• LINETOLINECLEARANCE - зазор между линиями трасс;  

• VIATOPADCLEARANCE - зазор между контактной площадкой и переходным 
отверстием;  

• VIATOLINECLEARANCE — зазор между контактной площадкой и линией 
трассы;  

• VIATOVIACLEARANCE - зазор между контактными площадками.  

Если результаты трассировки не удовлетворяют пользователя, то можно выполнить 
следующие команды:  

• Unroute All Nets - удаление всех проложенных цепей.  

• Unroute Conflicts — удаление всех цепей, имеющих помеченные на печатной плате 
конфликтные точки.  

• Unroute Net — удаление всей трассы одной цепи.  

• Unroute Connections - удаление трассы, соединяющей две контактные площадки.  

• Unroute Segment — удаление сегмента цепи.  

При интерактивной трассировке рекомендуется перед окончательным проведением 
цепи использовать команду Tools/Sketch Route. При указании на цепь подсвечивается вся 
электрическая цепь. Далее указывается один из контактов цепи и, не отпуская левую 
клавишу мыши, вычерчивается (неровной линией) предполагаемая трасса, которая после 
отпускания клавиши мыши проводится окончательно с соблюдением всех установленных 
правил трассировки.  

 

11 Автоматическая трассировка  
 

Автоматическая трассировка производится после выполнения команды Tools/Start 
Autorouter в меню автотрассировщика P-CAD ShapeBased Router (рис. 5.19). В процессе 
трассировки в строке состояний отражается ход трассировки: название текущего прохода 



трассировки, число разведенных цепей и количество введенных переходных отверстий, 
наличие конфликтов и т. д.  

Перед началом трассировки система выполняет анализ печатной платы и выбирает 
подходящую стратегию трассировки. В случае появления сообщения One or more 
connection cannot be routed (одно или более соединений не может быть проведено) 
проанализируйте текстовый файл *.LOG, внесите нужные исправления и начните 
трассировку заново.  

 

Рисунок 5.19-  Автоматическая трассировка  

На начальных этапах трассировки программа Shape-Based Router прокладывает 
трассы с нарушением технологических зазоров и даже с пересечением(!) трасс на одном 
слое. Такие конфликты указываются на экране кружочками желтого цвета. На 
последующих проходах конфликты устраняются, а если это не удается сделать 
трассировщику, то результаты трассировки вместе с оставшимися конфликтами передаются 
в редактор РСВ Editor и редактируются самим пользователем.  

Автотрассировку можно остановить по команде Tools/Pause Autorouter, 
возобновить по команде Tools/Restart Autorouter и прекратить по команде Tools/Stop 
Autorouter.  

При автотрассировке возможно задание еще нескольких ее локальных режимов (для 
этого необходимо остановить процесс автоматической трассировки):  

• Autoroute Connection (автоматическая трассировкга отдельных фрагментов 
электрической цепи) - автоматическая трассировка производится при 
последовательном выборе того или иного контакта электрической цепи;  

• Autoroute Net (автоматическая трассировка всей электрической цепи) - выбирается 
любой контакт нужной электрической цепи, а затем вся цепь разводится в 
автоматическом режиме;  



• Autoroute Component (автоматическая разводка всех связей компонента) — 
автоматическая разводка производится после указания на любой контакт 
выбранного компонента;  

• Autoroute Area — автоматическая трассировка области, выбранной пользователем.  

 

12 Составление отчетов  
 

По завершении трассировки по команде Reports/Reports выводится диалоговое окно 
(рис. 5.20), в котором можно указать перечень нужных отчетов, а затем вывести их на экран 
(кнопка View), или распечатать на принтере (кнопка Print), или сохранить в файле.  

 

Рисунок 5.20-  Список формируемых отчетов по результатам трассировки  

Список формируемых отчетов приводится ниже:  

• Pre-Route Synopsis — краткая информация об ожидаемых результатах трассировки;  

• Routing Statistics - краткий итоговый отчет о результатах трассировки;  

• Connections Not Routed - информация о неразведенных контактах;  

• Connections Not Fanned Out - данные о соединениях, не имеющих стрингеров;  

• Via Statistics — информация о переходных отверстиях в печатной плате;  

• Copper Per Layer - данные о длине проводников на каждом сигнальном слое и их 
суммарная длина;  

• Testpoints - данные о контрольных точках (если таковые были предусмотрены).  

Примечание.  

Все линейные размеры (Track Length) в отчетах заданы в системе единиц, 
установленных в окне Units закладки Parameters команды Options/Auto-
Router.  

Для возвращения в программу P-CAD РСВ с целью просмотра результатов трассировки и 
возможного редактирования этих результатов выполняется команда Save and Return.  



 
13 Верификация печатной платы  

 
После завершения разработки топологии печатной платы и перед формированием 

данных для выпуска фотошаблонов необходимо проверить плату на соответствие 
принципиальной схеме, правилам проектирования и технологическим ограничениям, т. е. 
тем правилам, которые установлены командой Options/Design Rules. Проверка 
производится с использованием утилиты DRC (Design Rule Check) Запускается утилита 
командой Utils/DRC. На рис. 5.21 показано окно указанной команды.  

Ниже приводятся опции правил проверки печатной платы:  

• Netlist Compare - сравнение списка соединений текущей печатной платы и 
соответствующей ей принципиальной схемы;  

• Clearence Violations - проверка заданных зазоров;  

• Text Violations - проверка правил написания текста;  

• Netlist Violations - проверка соответствия соединений текущей печатной платы и 
исходного списка цепей проекта;  

• Width Violations - проверка ограничений на заданную ширину трасс;  

• Unrouted Nets - проверка на наличие непроведенных цепей;  

• Unconnected Pins - проверка неподсоединенных выводов;  

• Net Length - проверка ограничений на длину цепей;  

• Silk Screen Violations - проверка зазоров между контактными площадками или 
переходными отверстиями в слое шелкографии;  

• Copper Pour Violations — проверка правильности выполнения зазоров в областях 
металлизации в сигнальных слоях;  

• Plane Violations - проверка во внутренних слоях типа «земля» и «питание» 
наложения областей металлизации, неправильного подсоединения к ним контактных 
площадок, переходных отверстий, изолированных областей металлизации;  

• Component Violations — проверка ошибок размещения компонентов;  

• Drilling Violations — проверка правильности сверления отверстий для штыревых 
выводов, сквозных и глухих переходных отверстий.  

В области Report Options указываются следующие опции проверок:  

• View Report — выводит текст отчета на экран монитора.  

• Summarize Ignored Errors - количество игнорированных ошибок;  

• Summarize Overriden Errors — количество перекрывающихся ошибок, вывод 
которых запрещен в закладке Miscellaneous диалогового окна Options Display 
команды Options/Display.  

В области Error Options используются опции:  

• Annotate Errors - индикация ошибок специальными маркерами;  



• Clear All Overrides - удаление всех маркеров перекрывающихся ошибок. 

 

 

Рисунок 5.21- Окно команды Utils/DRC  

 
Нажатие на кнопку Design Rules открывает диалоговое окно для задания 

технологических параметров проекта Options/Design Rules (см. выше).  
Нажатие на кнопку Severity Levels открывает диалоговое окно Rules Severity Level (см. 

выше) для присвоения ошибкам их приоритетности (ранга).  
После нажатия на кнопку Filename можно изменить имя файла (расширение *.drc), в 

который записываются найденные ошибки.  
После окончания всех установок параметров щелкните ОК.  
Поиск и анализ всех выявленных ошибок производится по команде Utils/Find Errors 

(рис. 5.22).  

 

Рисунок 5.22- Сообщение об ошибке выделенного контакта  



В поле окна выводятся номер ошибки (Error Number) и текстовое сообщение об 
ошибке. В окне Error Number можно перейти к очередной ошибке, а после нажатия на 
кнопку Jump To на экране монитора подсвечивается соответствующая ошибка.  

После исправления ошибки ее индикатор на экране автоматически удаляется.  
13 Сохранение проекта  

После всех процедур по формированию печатной платы, которые изложены в текущей 
главе, необходимо сохранить проект по стандартной команде File/Save (или File/Save As). 
Предварительно можно выбрать формат файла:  

• Binary Files - бинарный формат. Этот формат является более компактным и 
считается основным.  

• ASCII Files — текстовый формат. Этот формат используется для обмена данными с 
другими программами, например с программой SPECCTRA.  

ЗАДАНИЕ ПО ЛАБОРАТОРНОЙ РАБОТЕ 
1. Установить шаг сетки  
2. Установить зазор между проводниками  
3. Задатье атрибуты цепям и компонентам  
4. Произвести трассировку. 
4. Составить отчет.  
5. Произвести верификация печатной платы.  
 
Выходной файл –файл после трассировки с расширением *.PCB 
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